Logon to TC-AIMS II
NOTE:  A User ID for the user must be created in the TC-AIMS II SysAdmin program prior to attempting to logon.

1. Double Click the TC-AIMS II Icon.

2. Click OK.  

3. Enter the User ID as assigned by the SA (User Ids are case sensitive).

4. Enter password.

NOTE:  If this is the first time log in – the password tcaimsii will be used.  

5. Click the down arrow and select the appropriate server.

6. Click the down arrow and select the appropriate database.

7. Click OK.

8. If this is a first time log on, the Forced Change Password Window will open.  

9. Create a unique New Password with the validation rules listed below:

a. The password must be between 8 and 18 characters long.

b. The password must contain at least 3 out of 4 of the following:  upper case (A-Z), lower case (a-z), number (0-9), or special character (#$*_).

c. The password cannot contain repeating characters (“ee”, “TT”, “33”, etc.).

d. The password cannot be the default password.

10. Confirm the password in the Repeat New Password field.

11. Click OK to save.

12. Click OK after reading the Change Password message.  

NOTE:  When logging in, if an error message is received, such as “Invalid User/Password/Server/Database, perform the following checks:
a.
Re-enter the User ID and Password ensuring that the Caps Lock is off.

b.
Ensure that the correct server to connect to is selected.

c.
Verify that the computer is properly connected to the network.

d.
Verify the server has started in Sybase.

e.
Contact the System Administrator and verify the User has not been deactivated.

NOTE:  Once the above checks have been made, if the computer still will not connect to the database – contact the TC-AIMS II Helpdesk for further assistance.
Asset Management

This Business Process Area (BPA) provides the ability to create and manage a database of organizational assets using the following processes:  Manage Equipment, Manage Personnel, Manage Supplies, Manage Deployment Support Equipment, and Manage Sustainment. It also contains the following options:  Assign/Associate and Print/Create Labels  Each of the processes contains sub-processes and options that provide additional functionality.

Manage Equipment

Customize View

1.
Double-click Asset Management.

2.
Double-click Manage Equipment.  
3.
Double-click Manage Equipment.

4.
Click View and select Customize View.  

5.
Select the desired box(es) using one of the following methods:

· Select several individual field names by clicking on selected field name check boxes in the Visible column.

· Select all field name check boxes in the table by clicking Select All.

· Deselect all check boxes in the table by clicking Deselect All.

6.
Click OK.

Add Equipment Records

1. Double-click Asset Management.
2. Double-click Manage Equipment.
3. Double-click Manage Equipment. 
4. Select the UIC(s) by one of the following methods:
· Select individual UIC by clicking on it to highlight it.

· Select all the UICs at once by clicking on All.

5. Click the Directional Arrow to move the selected UICs to the Selected UICs side.

6. Click OK.

7. Click Add. 

8. Insert data in the General tab and click OK to save.

9. Verify and insert any additional information required in the remaining tabs.

10. Once all tabs have been updated click OK to save.

11. Click Add to add another record or Cancel to.

Update Equipment Records

1. Double-click Asset Management.
2. Double-click Manage Equipment.
3. Double-click Manage Equipment.  
4. Select the UIC(s) by one of the following methods:
· Select individual UIC by clicking on it to highlight it.

· Select all the UICs at once by clicking on All.
5. Click the Directional Arrow to move the selected UICs to the Selected UICs side.

6. Double Click the record that needs to be updated in the top portion of the screen.
7. Update the necessary fields on each tab.
8. Once all necessary fields have been updated, click OK to save.

9. Click the next record that needs to be updated or Cancel to close.

Temporarily Delete Equipment

1. To Delete an Individual Record from the OEL:

a. Double-click Asset Management.
b. Double-click Manage Equipment.
c. Double-click Manage Equipment.  

d. Select the UIC(s) by one of the following methods:
· Select individual UIC by clicking on it to highlight it.

· Select all the UICs at once by clicking on All.

e. Click the Directional Arrow to move the selected UICs to the Selected UICs side.

f. Click OK and then Search.

g. Double-click a record in the top portion of the screen.

h. Click the record to be deleted, 
i. Rright-click on highlighted record.
j. Select Delete.
i. Click OK when prompted “Are you sure you want to delete this record?” 

2.
To Delete Multiple Records from the OEL.

a. Double-click Asset Management.
b. Double-click Manage Equipment.
c. Double-click Manage Equipment.  
d. Select the UIC(s) by one of the following methods:
· Select individual UIC by clicking on it to highlight it.

· Select all the UICs at once by clicking on All.

e. Click the Directional Arrow to move the selected UICs to the Selected UICs side.

f. Click Search.

g. Right-click in the top portion of the screen to display the short cut menu select Multi-Delete.

h. Highlight the record(s) to be deleted using one of the following methods:

· Select several individual records by holding down the Control (Ctrl) key and clicking on each record to be.

· Select a group by clicking the first record of the group, holding down the Shift key and click the last record of the group.

· Select all records in the database by clicking Select All.

· De-select is used to unselect records the user does not want to delete.
i. Click Delete.

j. Click Close.

k. Click OK to save or Cancel to close.

Manage Deleted Equipment

Restore Temporarily Deleted Equipment Records

1. Double-click Asset Management.
2. Double-click Manage Equipment.
3. Double-click Manage Deleted Equipment.  

4. Select the record(s) to be restored by one of the following methods:

· Select several individual records by holding down the Ctrl key and clicking on each record selected

· Select a group by clicking on the first record of the group, holding down the Shift key, and clicking on the last record of the group

· Select all records in the database by clicking Select All.
5. Click Restore.  

6. Click Close to exit.

Permanently Delete Equipment Records

CAUTION:  This process will permanently remove records from the database.  They cannot be restored nor recovered. Permanently deleted records will need to be manually added back into the database.

NOTE:  Assets that are linked or assigned to a plan must be unlinked or unassigned before they can be deleted.

1. Double-click Asset Management.
2. Double-click Manage Equipment.
3. Double-click Manage Deleted Equipment.  

4. Highlight the record(s) to be deleted from the database by:

· Select several individual records by holding down the Ctrl key and clicking on each record to be removed.

· Select a group by clicking on the first record of the group, holding down the Shift key, and clicking on the last record.
· Select all records in the screen by clicking on the check box next to Select All in the bottom right corner of the screen.
5. Click Delete.

6. Click OK when prompted, “The selected record(s) will be permanently deleted and can not be recovered!”

7. Click Close to exit.

Manage Personnel

Customize View

1.
Double-click Asset Management.

2.
Double-click Manage Equipment.  
3.
Double-click Manage Equipment.

4.
Click View and select Customize View.  

5.
Select the desired box(es) using one of the following methods:

· Select several individual field names by clicking on selected field name check boxes in the Visible column.

· Select all field name check boxes in the table by clicking Select All.

· Deselect all check boxes in the table by clicking Deselect All.

6.
Click OK.

Add Personnel Records

1. Double-click Asset Management.

2. Double-click Manage Personnel.

3. Double-click Manage Personnel.  

4. Select the UIC(s) by one of the following methods:
· Select individual UIC by clicking on it to highlight it.

· Select all the UICs at once by clicking on All.

5. Click the Directional Arrow to move the selected UICs to the Selected UICs side.

6. Click OK.
7. Click Add.  

8. Insert data in the General tab and click OK to save.

NOTE:  The OK button can not be selected until the UIC, Service, Last Name and SSN are populated.  When Ok is selected the remaining Tabs are activated.

9. Verify and insert any additional information required in the remaining tabs.

10. Once all tabs have been updated click OK to save.

11. Click Add to insert another record or Cancel to close.

Update Personnel Records

1. Double-click Asset Management.

2. Double-click Manage Personnel.

3. Double-click Manage Personnel.  
4. Select the UIC(s) by one of the following methods:
· Select individual UIC by clicking on it to highlight it.

· Select all the UICs at once by clicking on All.

5. Click the Directional Arrow to move the selected UICs to the Selected UICs side.

6. After selecting the UIC(s), click OK and then Search.

7. Double click the personnel record that needs to be updated.

8. Update the necessary fields on each tab.

9. Once all fields have been updated click OK to save.
10. Click the next record that needs to be updated or Cancel to close.

Temporarily Delete Personnel Records

1. To delete an individual Personnel Record:

NOTE:  Personnel records that have been assigned to plans cannot be deleted until they are unassigned from all plans.

a. Double-click Asset Management.

b. Double-click Manage Personnel.

c. Double-click Manage Personnel.  

d. Select the UIC(s) by one of the following methods:

· Select individual UIC by clicking on it to highlight it.

· Select all the UICs at once by clicking on All.

e. Click the Directional Arrow to move the UICs to the Selected UICs side.

f. Click OK and then Search.

g. Click a record.

h. Right-click the selected record and select Delete.

i. Click OK when prompted, “Are you sure you want to delete this record?”
j. Click Cancel to exit.

2. To Delete Multiple Records from the OEL.

a.
Double-click Asset Management.

b.
Double-click Manage Personnel.

c.
Double-click Manage Personnel.  

d.
Select the UIC(s) by one of the following methods:

· Select individual UIC by clicking on it to highlight it.

· Select all the UICs at once by clicking on All.

e.
Click the Directional Arrow to move the UICs to the Selected UICs side.

f.
Click OK and then Search.
g.
Right-click in the top portion of the screen and select Multi-Delete.

h.
Highlight the record(s) to be deleted using one of the following methods:

· Select several individual records by holding down the Control (Ctrl) key and clicking on each record to be.

· Select a group by clicking the first record of the group, holding down the Shift key and click the last record of the group.

· Select all records in the database by clicking Select All.

· De-select is used to unselect records the user does not want to delete.
i.
Click Delete.

j.
Click Close.

k.
Click OK to save or Cancel to close.

Manage Deleted Personnel

Restore Temporarily Deleted Personnel Records

1. Double-click Asset Management.
2. Double-click Manage Personnel.
3. Double-click Manage Deleted Personnel.  

4. Select the record(s) to be restored by one of the following:

· Select several  individual records by holding down the Ctrl key and clicking on each record to be selected.

· Select a group by clicking on the first record of a group, holding down the Shift key, and clicking on the last record of the group.

· Select all records in the database by clicking the Select All.

5. Click Restore.  
6. Click Close to exit.
Permanently Delete Personnel Records

CAUTION:  This process will permanently remove records from the database.  They cannot be recovered or restored, and must be manually added back into the database.

NOTE:  Personnel that have been assigned to a plan(s) must first be unassigned before they can be deleted from the system.

1. Double-click Asset Management.
2. Double-click Manage Personnel.
3. Double-click Manage Deleted Personnel.  

4. Highlight the record(s) to be deleted using one of the methods below:

· Select several  individual records by holding down the Ctrl key and clicking on each record to be selected.

· Select a group by clicking on the first record of a group, holding down the Shift key, and clicking on the last record of the group.

· Select all records in the database by clicking the Select All.

5. Click Delete.

6. Click OK when prompted “The selected record(s) will be permanently deleted and can not be recovered!”  

7. Click Cancel to exit.

Manage Supplies

Manage Deployment Support Equipment (DSE)

Manage Sustainment
These three processes work identically to Manage Equipment and Manage Personnel.

Assign/Associate

Customize Views

1.
Double-click Asset Management.

2.
Double-click Assign/Associate.  
3.
Double-click Asset Management.

4.
Right Click in the left panel and select Customize View.  

5.
Select the desired box(es) using one of the following methods:

· Select several individual field names by clicking on selected field name check boxes in the Visible column.

· Select all field name check boxes in the table by clicking Select All.

· Deselect all check boxes in the table by clicking Deselect All.

6.
Click OK.

Sort command

1.
Double-click Asset Management.

2.
Double-click Assign/Associate.  

3.
Double-click Asset.

4.
Right Click in the left panel and select Sort.  

5.
Drag one or more of the selections to the window on the right side one at a time.

6.
Click OK.

Find All

1.
Double-click Asset Management.

2.
Double-click Assign/Associate.  

3.
Double-click Asset Management.

4.
Click Edit then Find.  

5.
Click Find what and type in item to search for.

6.
Click Find All.  

7.
Click Close.

Drag and Drop Method

1.
Double-click Asset Management.

2.
Double-click Assign/Associate.  

3.
Double-click ASSET MANAGEMENT.

4.
Left Click a record for a Red X.  Hold the shift or ctrl keys to select multiple records. 

5.
Click and hold the left mouse button.

6.
Drag the record directly over the item to be linked to and release the mouse button.  

7.
Click the radio button for the desired link type. 

8.
Click OK. 
Cut and Paste method

1.
Double-click Asset Management.

2.
Double-click Assign/Associate.  

3.
Double-click ASSET MANAGEMENT.

4.
Left Click the record to be linked and a Red X indicates the record has been selected. Hold the shift or ctrl keys to select multiple records.  

5.
Right-click one of the selected records and select Cut.  

6.
Right-click the record to be linked to and select Paste.  

7.
Click the radio button for the appropriate link type.

8.
Click OK.  

9.
Double-click the primary mover for linked details.  

Unlink Associations

1.
Double-click Asset Management.

2.
Double-click Assign/Associate.  

3.
Double-click on ASSET MANAGEMENT 

4.
Click the record to be unlinked to display a Red X indicating the record has been selected.  Hold the shift or ctrl keys to select multiple records.  

5.
Right-click the record and select Unlink.  The unlinked record will appear at the bottom of the equipment list.

Interface Wizard Task

This task within Asset Management provides the capability to bring equipment and personnel records from other service systems into the TC-AIMS II system and to export TC-AIMS II equipment and personnel data out to disk.

Imports

CAUTION:  If the import process experiences problems when attempting to import from another service system, verify that the directory or the file name does not contain a space.  Several of the Interfaces will not allow spaces in the path or file name. 

Workaround:  During some imports, the Windows NT operating system fails to accept when a disk has been removed from the computer and will display the following error, “tcaims.exe – No Disk”.   The workaround resolution for this error message is as follows:  Re-insert the diskette into the drive.  The error window will go away.  Then use Windows NT Explorer to copy the file from the diskette to a location on the hard drive.  The error window message should not reappear.
1. Click Wizards.  

2. Select Interfaces.

3.
Select Import/Export.  

4.
Click Asset Management radio button.

5.
Click OK.  

6.
Select Import then click Next.  

7.
Click the required interface.

a. To view records that were previously imported for a specific interface, click on the box beside Previously imported data only then click Finish.

b. To perform a new Import, click Finish.  

c. Select the location of the saved file and click Open.  

d. Click Ok.

NOTE:  If an import was previously performed and records remain in the Interfaces Newcargo AIT window – a message will display asking if you wish to delete these records.  Click on OK to delete the records and continue with the import.  Click on Cancel to stop the import process.

7.
Click Next.

8.
When finished verifying information in the New Interface window Click Apply. 

9.
Click Ok the number of records applied, updated or rejected. 

10.
At this point the user has three options:

a. Close the window and correct the rejected records at a later time.  The Interface Newcargo AIT window can be reopened by following steps 1-4a above.

b. Delete the rejected records by right mouse clicking on each record in the top listing and selecting delete from the drop down listing.

c. Correct the rejected records and apply them to the database.

Interfaces for Asset Management

AIT Import

ATLASS Import (Marines)

LOGMOD (*.PLN) Import (Air Force)

MANPER Pers Import (Air Force)

MDSSII Import (Marines)

NCFMIS Import (Navy)

ROLMS Import  (Navy)

SIDPERS Import  (Army)

TCACCIS Import  (Army)

TCAIMS II V3 Import

UD/MIPS Import

Exports

Workaround:  During some exports, the Windows NT operating system fails to accept when a disk has been removed from the computer and will display the following error message, “tcaims.exe – No Disk”.   The workaround resolution for this error message is as follows: Re-insert the diskette into the drive.  Re-export the file to a hard drive location.  Close the export window and the Error window message should not reappear.  If desired, delete the exported file from the hard drive.

TCAIMS II V3 Export

1.
Click Wizards.  

2.
Select Interfaces 

3.
Select Import/Export. 

4.
Click Asset Management.

5.
Click OK. 

6.
Select Export.  

7.
Click Next.  

8.
Highlight TCAIMSII V3.

8.
Highlight the UICs to export then click Export.

9.
Click Save on the temporary location.  This will be the default 

11.
Click down arrow for Save In and designate where the file will be saved.

12.
Click in File Name and enter a name.

13.
Click Save.

14.
Click OK when complete.

15.
Click Cancel to close.

16.
Click Cancel to close.

Reports Wizard

1. Click Wizard.

2. Click Reports. 

3. Click the radio button for Asset Management.

4. Click OK. 

5. Select the required report then click OK.  

AD HOC Reports

AdHoc Reports are created using InfoMaker, a commercial off-the-shelf product. 

1.
Select AdHoc report from the reports window.

2.
This will start the InfoMaker.  

3.
In Server Name, enter the name your standalone.

4.
Enter the User ID and password you use for TC-AIMS II.

5.
Leave the Application Name and Host Name fields blank.

6. Click OK.  

7. Click OK.

8. Click Report icon.

9. Click New button.  

10. Select the Data Source and Presentation Style then click OK.

11. Select the table(s) that you want to pull information from then select the column(s).
12. Click OK or close the table selection window.  

13. Select Preview from the Design menu.  

Note:  To make changes, select Edit Data Source from the Design menu.  

14. Save the report.

15. To print - preview the report and then select Print from the File menu.
16. Select Exit from the File menu.  InfoMaker closes and returns to TC-AIMS II.
Reports Available for Asset Management

Asset Calibration Report

Note:  The LTI and Calibration Date fields on the Maintenance tab must be filled in for the report to generate properly.

Asset Service Report

Note: The LTI and Service Date fields on the Maintenance tab must be filled in for the report to generate properly.

Asset Inspection Report

Note: The LTI and Inspection Date fields on the Maintenance tab must be filled in for the report to generate properly.

Combat Essential Equipment Report

Note: The CEE (Combat Essential Equipment) field on the General tab must be filled in for the report to generate properly.

Modification Report

Note:  The Plan Completion Date or Actual Completion Date on the Maintenance tab must be filled in for the report to generate. The LTI and PCN fields should also be filled in to generate all information on the report.

Association Report by Unit

Unit Audit Listing by Unit – Cargo Report

Unit Audit Listing by Unit  - Personnel Report

Unit Audit Listing by Unit – Vehicle Report
Note:  The UPTT Code on the Other Characteristics tab must be filled in for the report to generate properly.

Personnel Report by SSN

Personnel Report by Last Name

OEL Unit Equipment List
Print / Create Equipment Labels

1. Connect the printer to the COM port computer and turn the printer on.

2. Double-click Asset Management.

3. Double-click Print / Create Labels.  
4. Highlight the records that require labels by:

· Select individual records by clicking on each record.

· Select all records by clicking in the Select All check box.

5. Click Equipment Label.

6. Click Print.
7. Indicate the type of printer being used.
8. Click on the Setup button, in the label box.  

There are eight data elements; UIC, NSN, Pkg ID, Serial Nr, Item ID, MSE, Description, and Model Number.   The UIC, NSN, and Pkg ID selections are “grayed out” because they are not mandatory on the labels.  De-select any of the other fields by clicking in the box next to it.

NOTE:  The setup button is not available when 2D equipment labels are selected.  De-select any field by clicking in the box next to it.

9. Click download format and Save Shipping Information if required.

10. Click Print.  

11. Click OK when printer format is downloaded.

12. Click Ok when prompted, “Label printing complete.”

13. Click Close to exit.

14.  Click Cancel to exit.

Movement Planning

This BPA provides the ability to create equipment and personnel deployment listings, plan movements, load conveyances being used for movements and plan convoys using the following task: TPFDD Requirements, Create UDLs, Deployment Exercise, Convoy Planning. Each of these sub-processes contains various options.

TPFDD Requirements

View / Edit Movement Information

1. Double-click Movement Planning.

2. Double-click TPFDD Requirements.

3. Double-click View / Edit Movement.

4. Click on any record in the top window.

5. View and edit the movement detail as needed.

6. Click OK to save then click Cancel to close.

NOTE:  All edit functions should be made prior to creating segments and legs in order to update JFRG data.  Then additional changes must be made at the Segment/Leg level.

Assign/Prioritize UIC/View Requirements

NOTE: If the user has only one UIC assigned, this feature is not available; See Auto Plan.

1. Double-click Movement Planning.

2. Double-click TPFDD Requirements.

3. Double-click Assign/Prioritize UIC/View Requirements.  

4. Click a ULN record to highlight it.  

5. Click Assign/Prioritize UICs.  Displayed are two (2) options:  Assign UICs to ULNs and Prioritize UICs for ULNs.

6. Select the appropriate options and click OK.

a. If Assign UICs to ULNs is selected:  

b. The ULNs are not editable at this point.  If the ULNs were assigned to UICs prior to import (JFRG or V3-V3), the user cannot edit the Unit ID or Status columns.  If they were not assigned, the user can assign ULNs to a UIC or Forward to BDE, BN or CO for assignment.

1) Auto Plan—When AutoPlan is selected; the system automatically matches OEL assets to required equipment and assigns the ULN of the required equipment to the matched asset and associated records. It then creates Segment and Legs and assigns assets to the Segments and Legs based on Mode and Source Codes set in View Edit Movement Data.

a) Click Auto Plan.  

b) Click OK when prompted, ‘All “Linked Assets” will be assigned to the UDL/DEL regardless of requirements’.

c) Select Assets/OEL then OK.  The system performs the Auto Plan.

2)
GSUP-Generate Subordinate Unit Plans

This allows the user to generate separate plans for each of the units assigned to the ULNs.  These plans can then be imported to another TC AIMS II system (V3-V3) as a “shell plan” containing requirements only.  

NOTE: Using GSUP can be done before or after the Auto Plan.  

a) Click GSUP.  

NOTE: A warning message is displayed if there are any ULNs that are not assigned to a Unit ID.  All ULNs must have an assigned UIC before the GSUP can be performed.

b) Click Export.  

c) Select drive and path for exported files.

d) Click Save.  

e) Click Yes when prompted, “All exported files (*.txt) will be deleted in (the destination selected).  Would you like to continue?”

f) Click Cancel.

g) Click Cancel.

b.
If Prioritize UICs for ULNs is selected:  

1)
Click the Priority field beside each of the UICs and enter a number from 0 to 999.

2)
Click Auto Plan.  The Auto Plan UDL/Segments & Legs message window displays with the prompt, 

3)
Click OK when prompted, ‘All “Linked Assets” will be assigned to the UDL/DEL regardless of the requirement’.  

4)
Click the appropriate radio button and click OK.  

NOTE:  If the plan does not contain a UDL, the Create UDL window is not displayed and the requirements will be sourced from the OEL automatically.

NOTE:  If Auto Plan has been performed or if the user has manually created segments and legs, a message will be displayed that the system cannot autopopulate a plan that has pre-existing segments.  Click OK and delete any pre-existing segments and legs then  the user can run the Auto Plan.

5)
Click Cancel to close.

6)
Click Cancel to close.

NOTE:  Adjust the legs in the plan after using the auto functions with the mode of transportation.  It may be a land leg, but the system doesn’t know if it will be rail, bus, or convoy.  

Add/Edit ULNs

1.
Double-click Movement Planning.

2.
Double-click TPFDD Requirements.

3.
Double-click Add ULNs.  

4.
Select ULN.  Edit as required.

5.
To Add ULN, Right Mouse Click and select add.  

NOTE: ULN, UIC and US Armed Svc code are required fields in order to save a ULN.
Add Equipment Requirements

1.
Double-click Movement Planning.

2.
Double-click TPFDD Requirements.

3.
Double-click Add ULNs.  

4.
Select the required ULN.

5.
Click Add Equipment Requirements located at the bottom of the screen.  

6.
Add information as needed.

7.
Click OK when complete.  

8.
Click Add to add another record or Cancel to close.

Add Personnel Requirements

1.
Double-click Movement Planning.

2.
Double-click TPFDD Requirements.

3.
Double-click on the Add ULNs.

4.
Select the required ULN.

5.
Click on Add Personnel Requirements button located at the bottom of the screen.  

6.
Add information as needed.

7.
Click OK when complete.  

8.
Click Add to add another record or Cancel to close.

Delete ULNs

1.
Double-click Movement Planning.

2.
Double-click TPFDD Requirements.

3.
Double-click Add ULNs.  

4.
Right Mouse Click the desired ULN and select Delete.

NOTE: A ULN cannot be deleted if it is used anywhere in the plan.
Create UDL

Assign/Source Equipment With TPFDD Requirements

There are 2 ways to match assets to requirements and assign those assets to the UDL; Automatically (Auto Match) and Manually.

1. Auto Match Requirements
NOTE:  When TPFDD requirements are established, three windows are displayed.  

a.
Double-click Movement Planning.

b.
Double-click Create UDL.

c.
Double-click Assign/Source Equipment. 

d.
Open a plan if not open.

e.
Click Auto Match.  Select “Yes to all” for linked items.

f.
When finished, click on OK to save.

NOTE: The system cannot determine which piece of equipment to assign.  It assigns the first in line.

NOTE: Click above the Requirements table.  The Hide button changes to show.  This feature will hide and requirements that are fulfilled to 100%.  Click Show to show all requirements.  Click Hide OEL.  This function hides the entire OEL table.  Click show to return table.

g.
Click OK to save.


NOTE:  Assets not highlighted that are linked to assets that are highlighted will be assigned.

h.
Click Cancel to close.

2.
Manually Match Requirements
a.
Double-click Movement Planning.

b.
Double-click Create UDL.

c.
Double-click Assign/Source Equipment.  

d.
Open a plan if not open.

e.
Click the Requirement and select the matching OEL record. 

f.
Click Assign, Select “Yes to all” for linked items.  

g.
Click OK to save.


NOTE:  Assets not highlighted that are linked to assets that are highlighted will be assigned.

h.
Click Cancel to close.

Assign/Source Equipment Without TPFDD Requirements

1. Double-click Movement Planning.

2. Double-click Create UDL.

3. Double-click Assign/Source Equipment. 

4. Open a plan if not open.

5. Highlight all required equipment in the OEL.

6. Click Assign.

7. Click OK to save.

8. Click Cancel to close.

Add Equipment to UDL but not the OEL

This function allows the user to add equipment to the UDL, without affecting the OEL.  This equipment will be in the Plan only.

NOTE:  If this equipment is unassigned then it will no longer exist and must be recreated.
1. Double-click Movement Planning.

2. Double-click Create UDL.

3. Double-click Assign/Source Equipment.  

4. Open a plan if not open

5. Click the UDL Details tab.

6. Right-click at the top of the screen and select Add.  

NOTE:  The window displayed is identical to Asset Management.
7. Input all necessary information and click OK.

8. Click Cancel.  The Assign/Source Equipment screen returns.

Un-Assign Equipment Records of UDL

1. Double-click Movement Planning.
2. Double-click Create UDL.

3. Double-click Assign/Source Equipment.  

4. Open a plan if not open.

5. Select the item(s) of equipment to be un-assigned on the UDL.

6. Click Un-Assign and click OK to save.

NOTE: Any requirements affected by the Un-assign function will no longer be highlighted in green.

7. Click Cancel to close.
Assign/Source Personnel UDL Roster with Requirements
1. Auto Match Requirements.

a. Double-click Movement Planning.

b. Double-click Create UDL.

c. Double-click Assign/Source Personnel.  

d. Open plan if not open.

e. Click Auto Match.  

f. Click OK button to.

g. Click Cancel to close.

NOTE: Click above the Requirements table.  The Hide button changes to show.  This feature will hide and requirements that are assigned.  Click Show to show all requirements.  Click Hide OEL.  This function hides the entire OEL table.  Click show to return table

2. Manually Match Requirements.

a. Double-click Movement Planning.

b. Double-click Create UDL.

c. Double-click Assign/Source Personnel.

d. Open plan if not open.

e. Highlight personnel needed to fill the requirement.

f. Click Assign.

g. Click OK to save.

h. Click on Cancel to close.

Assign/Source Personnel UDL Roster without Requirements

Assign Personnel to UDL

1. Double-click Movement Planning.

2. Double-click Create UDL.

3. Double-click Assign/Source Personnel.  

4. Open plan if not open.

5. Select the desired personnel from the Personnel List.

6. Click Assign then click OK to save.

View/Edit Personnel Records

1.
Select the Assign Personnel tab make changes as necessary.

2.
Click the Details tab make changes as necessary.

3.
Click the Deployment Details tab make changes as necessary.

Un-Assign Personnel

1.
Double-click Movement Planning.

2.
Double-click Create UDL.

3.
Double-click Assign/Source Personnel.  

4.
Open plan if not open.

5.
Select the personnel to be unassigned in the Personnel List.

6.
Click Un-Assign.

7.
Click OK to save.

8.
Click Cancel to close.

Deployment/Exercise

Movement Plan

Segments Tab

Add Segments

1.
Double-click Movement Planning.

2.
Double-click Deployment/Exercise.

3.
Double-click Movement Plan. 

4.
Click the Segment Tab. 

5.
Click the Add button. 

6.
Pick the Strategic Lift Mode and press OK. A new segment displays in the top window.

7.
Select radio buttons of MILSTAMP and GEOLOC Look-up options.


NOTE:  If the plan does not contain an OPLAN ID the default will be MILSTAMP.

8.
Enter necessary information.
9.
Click OK to save.

Insert Segments

1.
Double-click Movement Planning.

2.
Double-click Deployment/Exercise.

3.
Double-click Movement Plan. 

4.
Click the Segment Tab. 

5.
Click the Insert.  

6.
Pick the Strategic Lift Mode and press OK.  A new segment displays in the top window.

7.
Select radio buttons of MILSTAMP and GEOLOC Look-up options.

8.
Enter necessary information.

9.
Click OK to save.

Delete Segments

1.
Double-click Movement Planning.

2.
Double-click Deployment/Exercise.

3.
Double-click Movement Plan. 

4.
Select the Segments tab.

5.
Select the Segment you wish to delete.

6.
Click Delete.  

7.
Click Yes when prompted with “Are you sure you want to delete this Segment?”

8.
Click OK to save.

Consolidate Segments

NOTE:  For either format MILSTAMP or JOPES all the data in both Segments must be identical

1.
Double-click Movement Planning.

2.
Double-click Deployment/Exercise.

3.
Double-click Movement Plan. 

4.
Select the Segments tab.

5.
Click Consolidate.

6.
Click OK to save.

Auto Create Segments

1.
Select the Segments tab.

2.
Select radio buttons of MILSTAMP and GEOLOC Look-up options.

3.
Click Auto Create.  

NOTE: For the JOPES Format the user must have movement data, to include Mode and Source Codes, in TPFDD portion of movement planning.  This is supplied from a JFRG II import or input manually.  

4.
Select the required ULNS or Click Select All.

5.
Check Assign Equipment/Assign Personnel if required.


NOTE:  If the format is MILSTAMP the system uses the Preferred Mode to Port code set in Movement Planning to assign assets.  If JOPES is used the system uses the Mode and Source Codes in View/Edit Movement Information to assign assets. 

4.
Click OK to save.  The system returns to the Movement Plan screen.

Legs Tab

Add Legs

1.
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.  

4.
Click the Legs tab.

5.
Select the mode of transportation in the top window.


NOTE:  If the movement does not require a Strategic Move then use the Destination leg for the movement unless there is a change somewhere in the movement. 

6.
Select radio buttons of MILSTAMP and GEOLOC Look-up options.

7.
Click Add.  

NOTE:  Each Segment is composed of three parts, Mode to Port, Strategic Mode (Port of Intermediary Stop (POI)), and Destination.

8.
Enter all necessary information.

9.
Click type of SHUTTLE check box if desired.

10.
Click OK to save.
Create a POI (Point of Intermediary)

NOTE:  When the Strategic Leg has data, the POI becomes available.  

1.
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.  

4.
Click the Legs tab.

5.
Select POI.

6.
Click Add.  

7.
Select radio buttons of MILSTAMP and GEOLOC Look-up options.

8.
Enter all necessary information.

9.
Click type of SHUTTLE check box if desired.

10.
Click OK to save.
Add Additional POI’s

1.
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.  

4.
Click the Legs tab.

5.
Select POI.

6.
Click Add.  

NOTE: The user can add as many POIs as necessry.

7.
Select radio buttons of MILSTAMP and GEOLOC Look-up options.

8.
Enter all necessary information.

9.
Click type of SHUTTLE check box if desired.

10.
Click OK to save.
NOTE: To see if more than one POI exists, select a  POI.

Manage Multiple POI’s

1.
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.  

4.
Click the Legs tab.

5.
Select POI.
6.
Select POI for edit.

NOTE:  The user can make adjustments to the Leg data window.

7.
Click OK to close the window and allow editing of the POI.

8.
Select radio buttons of MILSTAMP and GEOLOC Look-up options.

9.
Enter all necessary information.

10.
Click type of SHUTTLE check box if desired.

11.
Click OK to save.

Create a “Pre Mode to Port” leg:

NOTE:  When leg information exists for a Mode to Port Leg, the user will have access the Pre Mode button located on the left side of the conveyance type.  (Located just under the colored bar)

1. 
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.  

4.
Click the Legs tab.

5.
Select a Pre Mode Button.

6.
Click Add.  

7.
Select the desired conveyance type and click OK.  

8.
Select radio buttons of MILSTAMP and GEOLOC Look-up options.

9.
Enter all necessary information.

10.
Click type of SHUTTLE check box if desired.

11.
Click OK to save.

NOTE:  The Pre-Destination Leg is processed in the same way.

Create a “Pre Destination” leg:

NOTE:  When leg information exists for a Destination Leg, the user will have access the Pre Mode button located on the left side of the conveyance type.  (Located just under the colored bar)

NOTE:
The GEOLOC Code in the Destination leg must be changed to reflect where the Pre Destination leg will begin.

1. 
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.  

4.
Click the Legs tab.

5.
Select a Pre Mode Button.

6.
Click Add.  

7.
Select the desired conveyance type and click OK.  

8.
Select radio buttons of MILSTAMP and GEOLOC Look-up options.

9.
Enter all necessary information.

10.
Click type of SHUTTLE check box if desired.

11.
Click OK to save.

Delete Legs

1. 
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.  

4.
Select the Legs tab.

5.
Click Delete. 

Consolidate Legs

NOTE:  For either format MILSTAMP or JOPES all the data in both Segments must be identical

1. 
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.  

4.
Select the Legs tab.

5.
Select radio buttons of MILSTAMP and GEOLOC Look-up options.

6.
Click the Consolidate button.

7. 
Select the Options for Consolidation.

7.
Click OK to save.

Equipment Tab

Assign Equipment

1.
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.

4.
Select the Equipment tab.  

5.
Select the desired Leg and item(s) of equipment and click Assign.

7.
Click OK to save.

Un-assign Equipment

1.
Select the Equipment tab.

2.
Click on selected equipment to be unassigned

3.
Click on the leg that has equipment to be unassigned.

4.
Click Unassign.  

5.
Click OK to save.

Equipment Load Lists

1.
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.

4.
Select the Equipment tab.  

5.
Click Load Lists.  

6.
Select the desired mode of transportation and click OK.  

7.
Click Print LoadList.  

Personnel Tab

Assign Personnel

1.
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.

4.
Select the Personnel tab.

5.
Click the Leg that has personnel to be assigned.

6.
Click the person(s) to be assigned. 

7.
Click Assign.

8.
Click OK to save.

Unassign Personnel

1.
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.

4.
Select the Personnel tab. 

5.
Click on the Leg that has personnel to be unassigned.

6.
Click Unassign.  

7.
Click OK to save.

Personnel Load Lists

1.
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Movement Plan.

4.
Select the Personnel tab. 

5.
Click Load Lists.  

6.
Select the desired mode of transportation and click OK.  

7.
Click Print LoadList.

8.
Click Cancel to exit.

Create Mobile/Secondary Loads

1.
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3. Double-click Create Mobile/Secondary Loads.  

4.
Double-click on the Plan Name to display the equipment list.


NOTE:  This section works the same was as Assign/Associate in Asset Management.

Create Container/Pallet Load List

Mark items to be in Containers

1.
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Create Container/Pallet Load List.  

4.
Select item(s) in the UDL that are to be placed in a container and palletized.

5.
Click an Options radio button.  A code will appear depending on the Options selection:

· Container- C

· Pallet- P

6.
Click the Containers or Pallet type to match the option selected and the Maximum Dimensions will populate.

7.
Click OK and then click Calculate.  

NOTE: When the item(s) of equipment will not calculate because it’s size exceeds the container/pallet; the user will receive a Rejection Notice. 
NOTE:  If the Container Maximum Dimension window displays height, width, length and weight values of 1, 1, 1, and 1, it is an indication that the equipment item selected for container insertion does not have its dimensions listed in the Equipment Characteristics Data Files. As a result, the selected equipment item may be rejected for containerization or palletization.

8.
Click Print the load list, if required, and then Cancel to close. 

Unmark Contained/Palletized Items

1.
Double-click Movement Planning.

2.
Double-click Deployment/ Exercise.

3.
Double-click Create Container/Pallet Load List.  

4.
Click item in the UDL in the Create Container/Pallet Load List screen.

5.
Click the Options None radio button.

6.
Click OK to save.

Select Request Support Mode

Create Request

1. Double-click Movement Planning.

2. Double-click Deployment/ Exercise.

3. Double-click Select Request Support Mode.  

4. Select Create Request.

5. Click OK.  

6. Click the down arrow and select the desired leg needed for the support requirement.

7. Click OK.  

7. Click the item(s) in the UDL table that require support they highlight in dark blue.

8. Click the down arrow of the Type Support Requested and select a mode of transportation.  

· MHE Origin-used if Material Handling Equipment is required at origin.

· MHE Destination- used if Material Handling Equipment is required at destination.

· Transportation- used if transportation support is needed.

· Driver required- used if a driver is needed to fulfill the support requirement.

9. Click Add. 

NOTE: To delete equipment in the Assets Requiring Logistical Support, highlight it and click Delete.

10. Click the Request tab.

11. Click the down arrow of the Priority data field and select the current priority.

12. Click the down arrow of the Security Class data field and select the current security class.

13. Click the down arrow of the Status data field and select the current status.

14. Double-click the Date/Time data field to display the calendar.

15. Double-click the date and type in the time.

Note:  There is no limit on the number of requests that can be made for a specific plan leg. 

16. When complete, change status from Pending to Receive. 

17. Click OK to save.  

18. Click OK when prompted “Request was successfully created.”

19. Click Cancel to return to the Select Mode screen.

Update Request

1. Double-click Movement Planning. 

2. Double-click Deployment/ Exercise.

3. Double-click Select Request Support Mode. 

4. Select Update Request.

5. Click OK.  

6. Make a selection from the View group box for the type of rollup required.

· All

· Request NR

· UIC

NOTE:  When selecting Request NR or UIC, enter the required information.

7. Click Retrieve.  

8. Select a request and click OK.  

9. Complete all data fields as required.  

· Rollup- returns the user to the Request/Task Rollup screen with the functions to print, delete, or select another request listed in the table.

· Export- allows the user to export the request to a file in the computer or to a diskette to send to higher headquarters.

· Delete – allows the user to delete the request.

· OK – allows the user to save the updated information to the database.

· Cancel – allows the user to exit the current screen.

7. Click OK to save.

8. Click Cancel to return to Select Request Support Mode.

View Request

1. Double-click Movement Planning. 

2. Double-click Deployment/ Exercise.

3. Double-click Select Request Support Mode. 

4. Select View Request.

5. Click OK.  

6. Select All.

7. Click Retrieve.

8. Highlight the request you want to view. 

9. Click OK.

Import Request

1. Double-click Movement Planning. 

2. Double-click Deployment/ Exercise.

3. Double-click Select Request Support Mode. 

4. Select Import Request.

5. Click OK.  

6. Perform the steps necessary to import a file.  

Convoy Planning

Create Routes

Add Route Nodes

1.
Double-click Movement Planning.

2.
Double-click Convoy Planning.

3.
Double-click Create Routes.  

4.
Right-click the screen and select Add.

5.
Click the down arrow adjacent to the Node type and select type of location.

NOTE: All selections except Location use the same screen to receive data.  If Location is selected and is based on GEOLOC then the GEOLOC lookup table will open.  Search for the necessary Location and click Ok..

6.
Double-click the State data field and select the desired state from the search window.

7.
Double-click the Ait Location Cd data field and select the AIT location.

8.
Double-click the TZ Node data field and select the TZ Node code.

9.
Enter any additional information such as restrictions.

10.
Select the appropriate Node Points.

11.
Click OK to save.

Update Route Nodes

1.
Double-click a Node.

2.
Click the data fields that need to be modified and make changes.

3.
Click OK to save 

4.
Click Cancel to exit.

Add Route Legs

1.
Double-click Movement Planning.

2.
Double-click Convoy Planning.

3.
Double-click Create Routes.

4.
Click on the Leg tab.

5.
Right-click and select Add from.  

6.
Type in the Leg Name.

7.
Click the down arrow adjacent to the Origin Node and select the criteria.

8.
Click the down arrow adjacent to the Destination Node and select the criteria.

9.
Enter all necessary information.

10.
Click OK to save.

11.
Click Cancel to exit.

Add Routes

1.
Double-click Movement Planning.

2.
Double-click Convoy Planning.

3.
Double-click Create Routes.

4.
Click on the Route tab.

5.
Right-click and select Add.  

6.
Type in the information in the Route Name.

7.
Click the down arrows for the Origin and Destination and select information.

8.
Click the desired Populate Leg Options radio button.

· Automatic - After the user clicks on the Populate Legs button the system will automatically populate the Assigned Routes Legs table from the Available Route legs table.

NOTE:  If the Complete Route has multiple possibilities the first Route found will populate the Assigned Routes Legs.

· Custom - After the user clicks on the Populate Legs button all Available Route Legs appear.  The user left clicks on an available route and uses the mouse to drag it to the Assigned Routes Legs table.

9.
Click Verify Route.

NOTE:  If there are no errors, the system will place an “X” in the Approved check box.  If the route does not flow correctly then it will error out.  Example of a good route A to B, B to C, C to D. Bad route A to B, B to F, C to D.

10.
Click OK to save.

11.
Click Cancel to exit.

Assign/Validate Routes

1.
Double-click Movement Planning.

2.
Double-click Convoy Planning.

3.
Double-click Assign/Validate Routes.

NOTE:  If a route has not been assigned, the system will attempt a match from the database using similar origin and destination.  If this cannot be accomplished, the user is required to create a route through the Create Routes function.

4.
Select desired Convoy in the top window.


NOTE: If a good assigned route is available it will display the information.  If prompted with “There is no route for Origin and Destination” Click Ok.  Then click Available Routes.  A box will appear with all created routes.  Select the route you designed for this movement and click Ok.  When prompted with “The route selected may not match Origin or Destination of the Convoy” click Ok.  The route information is then populated.

5.
Click the Convoy Name and type in the name.

6.
Double-click on Preferred Departure Date and Scheduled Departure Date to display the calendars.

7.
Select the desired dates.

8.
Click Assign/Validate.

NOTE:  If validation fails, the Invalid Route screen displays describing the problem(s).  Click on the Details tab to view the specifics, (i.e. Vehicle oversized/overweight).  Click OK to return to the list of failures and then click OK to return to the Assign/Validate screen.  Adjustments must be made to the route in the Deployment /Exercise Movement Plan process or in Create UDL process.

9.
Click OK to save.

10.
Click Cancel to exit.

Assign Convoy Points

1.
Double-click Movement Planning.

2.
Double-click Convoy Planning.

3.
Double-click Assign Convoy Points. 

4.
Click the down arrow adjacent to Pick Convoy and select the convoy name.  

5.
Click the Assigned Route Leg(s) to display the Nodes Assigned.

6.
Click the Nodes to display the Convoy Point Options check boxes and data fields.

7.
Click the required check box(es) and type in required information.

8.
Click OK to save.

9.
Click Cancel to close.

Assign Vehicles to March Serials
(NOTE: If user is going to assign vehicles to the March Unit execute Assign Vehicles to March Units first)

1.
Double-click Movement Planning.

2.
Double-click Convoy Planning.

3.
Double-click Assign Vehicles to March Serials.

4.
Click the down arrow adjacent to the Pick Convoy.

5.
Click the desired convoy name.  

6.
Click OK. 

7.
Click OK.  

8.
Select an item of equipment.

9.
Click Assign.  

NOTE:  If the wrong vehicle is assigned as either pace setter or trail vehicle, correct it by highlighting the vehicle and clicking on the desired radio button to change it.
10.
Click Unassign if any vehicle needs to be removed from the convoy.

11.
Click OK to save. 

12.
Click Cancel to exit.

Assign Vehicles to March Units

A March unit is the smallest element in a convoy and may have up to twenty-five (25) vehicles assigned.

1.
Double-click Movement Planning.

2.
Double-click Convoy Planning.

3.
Double-click Assign Vehicles to March Unit.

4.
Assign Vehicle to March Unit then Click OK
5.
Assign to March Serial then Click OK
Assign PAX (passengers) to Vehicles
1.
Double-click Movement Planning.

2.
Double-click Convoy Planning.

3.
Double-click Assign Pax to Vehicles.  

4.
Click the down arrow adjacent to the Convoy to select a convoy.  

5.
Select the personnel and vehicle(s).

6.
Click Assign.  

7.
Click the assigned individual(s).

8.
Click the appropriate position assignment of the individual.

9.
Click an individual and click UN-Assign to remove that person from any vehicle.

10.
Click Hide to view only the unassigned personnel.  Click Show to view all personnel.

11.
Click OK to save.

12.
Click Cancel to exit.

Estimate Travel Time
1.
Double-click Movement Planning.

2.
Double-click Convoy Planning.

3.
Double-click Estimate Travel Time.  

4.
Click the down arrow adjacent to the Convoy to select the convoy leg.  

NOTE:  Only the Gap Information and Additional Time Considerations fields are available.  

5.
Input all required information.

6.
Click OK to save.

7.
Click Cancel to exit.

Identify Logistical Requirements
1.
Double-click on Movement Planning.

2.
Double-click on Convoy Planning.

3.
Double-click on Identify Logistical Requirements.  

4.
Click the down arrow adjacent to the Convoy to select a convoy name.

5.
Click a convoy name.

6.
Input all required information.

7.
Click on one of the Form buttons:

· Form 1265- Convoy Clearance Request

· Form 1266- Special Hauling Permit.

8.
Input all required information if needed and click OK.

MP Loader
This process provides the capability to prepare equipment or personnel loads for subsequent movement from the Origin (POO) to a Destination (DEST) as assigned in Movement Planning.  

1.
Open plan if not open.

2.
Double-Click Movement Planning.

3.
Double-Click MP_Loader.

4.
Click the (+) by Segment to display Legs.

5.
Click the leg to display information.

6.
Click View Load List.

7.
Click the X to close the Load list.

8.
Double-Click the Leg to open MP_Loader.

9.
Proceed with one of the following conveyance procedures.

a.
Rail—Mandatory Field (M); Not Mandatory Field (N)

NOTE: Create RailRoad Ramp in Reference Tables prior to creating Train. 

1)
Click Staging.

2)
Click Add Stage. 
3)
Click OK when prompted, “Value required for this item”.
4)
Enter the Location Name, and click Save Stage.  

5)
Highlight equipment, and click Assign Items.

6)
Highlight passenger(s), and click Assign PAX.

7)
Click the X to close Staging Area.

8)
Right-click the in the Train and Setups section of screen.

9)
Click Add a Train/Setup.  

10)
Enter a Train Id (M).

11)
Enter a Setup Id (M).

12)
Enter a Description (N).
13)
Enter the RR Delivery (N).

14)
Enter the Depart Date (N).  

15)
Enter the Arrive Date (N).  
16)
Enter a Destination (N).

17)
Enter a Location (N).

18)
Click Default Dimensions (M).
19)
Click the down arrow and select the Ramp desired (M).

20)
Click the down arrow and select the Stage desired (M)
20)
Click OK to continue.

21)
Select Auto Load.

22)
Check the Specify Rail Cars to Auto Load box.  

23)
Click Run Auto Load.  

24)
Enter the Quantity, for the Rail Car Type required.
25)
Click OK.  
b.
Truck, Plane, Bus

1)
Click Add.

2)
Scroll down the list until the type of vehicle required.

3)
Click Add. 

4)
Edit the number required.

5)
Click Ok.

6)
Double-Click the newly created conveyance.

7)
Click the Available Cargo tab.

8)
Select the radio button for Standard or Extended and Equipment or Pax
9)
Select all Cargo/Personnel to be loaded on this conveyance.

10)
Click Load.

NOTE:  If the equipment being loaded is too large for the selected conveyance the system will <Cargo exceeds conveyance length restrictions.  Load anyway?>.  Select Yes, Yes to All, or Cancel.

11)
Click on Loaded Cargo tab.

12)
Verify the all cargo loaded.

13)
Click Ok to save.

14) Click Add to add additional conveyances.

15) Click Cancel to close.

View results

1.
Highlight the desired loaded conveyance.

2.
Click the Results tab.

3.
Click the drop down arrow to right of the Report Selection.  

4.
Click the required option.  

Save and Print load list.

1.
Click File.  

2.
Click Save As.  

3.
Enter the File name.


4.
Click the drop down arrow in Save as type.  

5.
Highlight and click Powersoft Report.

6.
Click the drop down arrow in Save in.  

7.
Select the drive or folder to be saved to.

8.
Click the Save. 

9.
Click OK when prompted with “File Saved Successfully”.

10.
Click on Tools. 

11.
Click Report Viewer. 

12.
Click the drop down arrow to the right of Look in. 

13.
Select the drive or folder the file was saved to.

14.
Click on the file to be printed and click Open.

15.
Click File.

16.
Click Print.

Unload Equipment/Personnel from A Conveyance

1.
Double-click the conveyance unloaded. 

2.
Click the Loaded Cargo tab.

3.
Select either the Equipment or Personnel radio button.

3.
Click the record to Unload. 


NOTE:  To select all records-- Click the first record hold down the Shift key and click the last record

4.
Click Unload. 

5.
Click Cancel to Return to MP Loader Window.

Delete a Conveyance

1.
Right click on the conveyance to be deleted.

2.
Select Mark a Conveyance for Deletion.

3.
Right click then select Delete all Marked (Selected) Conveyances.

4.
Click the Yes when prompted with “Are you sure”. 

Delete A Train

1.
Right click in Train and Setups.  

2.
Click Delete a Train.  

3.
Click Yes when prompted “Are you sure” 

NOTE: If the train has rail cars assigned they will be deleted and automatically return any equipment or personnel loaded to their load lists.
Locate Equipment

1.
Click Locate Equipment.  

NOTE:  The top panel contains search criteria that are separated into two CRITERIA Select areas.  In Select1 you can enter the PKG ID (Package Identification) and/or the Serial NR (Number).  In Select2, you can enter the Bumper NR, UIC, ULN NR, UTC NR, Dep. Echelon NR, and/or Increment Id NR.  You can either search by Select1 or Select2 criteria.  

a.
Enter PKG ID and/or the Serial NR In CRITERIA Select1. 
b.
With this data entered click criteria in Select2.  

NOTE:  All the Select2 become shaded gray and cannot be accessed.

c.
Click Locate.  

d.
Click GoTo Selected Equip.  

e.
Click the X to close the View Contents window.

f.
Click the X to close the Conveyances screen.

OR:

a.
Enter Criteria In CRITERIA Select2.

b.
With this data entered click on the Serial NR in Select1.  

NOTE:  All the Select1 becomes shaded gray and cannot be accessed.

c.
Click Locate.  

d.
Click GoTo Selected Equip.  

NOTE:  To locate the item, double click on the highlighted record.  This will display the tabs.  Select the Loaded Cargo tab and scroll to the item.

e.
Click the X to close the Conveyances window.  

COMPASS

A Record Tab

This tab has general unit information for railhead operations.

1.
Double-click Movement Planning.

2.
Double-click Compass.  

3.
Choose COMPASS Header Record.

· ULN
· Echelon
NOTE: The choices above are available for the type of report to be sent.

4.
Click OK.

5.
Click the drop down arrow for UIC.

6.
Double-click the in the ULNs field and select it. 

7.
Input all necessary information.

8.
Double-click the Dmod and select the shipment mode.

9.
Click Insert and the user can add other UICs in their information.

10.
Click OK to save.

NOTE: Clear Export Data will remove the information sent from the currently opened plan and allow a new edited export the capability of being sent.

H Record Tab

This tab has location information for loading of railhead operations.

1.
Click the drop down arrow for the UIC.

2.
Input all necessary information.

3.
Click Contingency Standing Route Order (CSRO) if a carrier has been contracted.

4.
Click OK to save.

J Record Tab

This tab has more specific information for the types of Railcars; Trailers, Sea Vans and Miscellaneous type wheeled vehicles that will be transported.  

1.
Click the drop down arrow for the UIC.

2.
Input all necessary information.

3.
Click OK to save.

Error Checklist Tab

This tab contains the following information:

· Errors that pertain to the Compass data imported into the system.

· Displays the Compass DF, Compass EG, Compass H1, Compass H2, Compass H3, and Compass J record tabs associated with an import.

· Displays the Rejected and Corrected reasons with a list of records imported for each existing record.

NOTE: Any corrections must be done under the associated tab(s) for that record.

1.
Click the required Tab.

2.
Click the data field with error and correct the information.

3.
Click OK save.

4.
Click Cancel to exit.

Interface Wizard

This task within Movement Planning provides the capability to import equipment and personnel records from other service systems into the TC-AIMS II system and to export TC-AIMS II equipment and personnel data out to disk.
Imports

The following steps will walk you through the process of bringing in equipment or personnel information from other service systems.

CAUTION:  If the import process experiences problems when attempting to import from another service system, verify that the directory or the file name does not contain a space.  Several of the Interfaces will not allow spaces in the path or file name.  The system will not allow two plans to be created with the same name.  User may experience problems when attempting to import a plan that exists as a plan in the current database or in the Logically deleted table.  Verify that the plan you are trying to import does not already exist in the system or in the Logically Deleted table.

WORKAROUND:  During some imports, the Windows NT operating system fails to accept when a disk has been removed from the computer and will display the following error, “tcaims.exe – No Disk”.   The workaround resolution for this error message is as follows:  Re-insert the diskette into the drive.  The error window will go away.  Then use Windows NT Explorer to copy the file from the diskette to a location on the hard drive.  The error window message should not reappear.

1.
Click Wizards.

2.
Select Interface.

3.
Select Import/Export.  

4.
Click Movement Planning radio button.

5.
Click OK.  

6.
Click Import then click Finish.

7.
Select the required Interface.

a.
To view records that were previously imported for a specific interface, click on the box beside Previously imported data only then click Finish.

b.
To perform a new Import, click Finish.  

c.
Select the location of the saved file and click Open.  

d.
Click Ok.

NOTE:  If an import was previously performed and records remain in the Interfaces Newcargo AIT window – a message will display asking if you 

wish to delete these records.  Click on OK to delete the records and continue with the import.  Click on Cancel to stop the import process.

8.
Click Finish.  

9.
Select the drive where the file is located and click Open.

10.  When finished verifying information in the New Interface window Click Apply.

11.
Click Ok the number of records applied, updated or rejected. 

12.
At this point the user has three options:

a.
Close the window and correct the rejected records at a later time.  The Interface Newcargo AIT window can be reopened by following steps 1-4a above.

b.
Delete the rejected records by right mouse clicking on each record in the top listing and selecting delete from the drop down listing.

c.
Correct the rejected records and apply them to the database.

Interfaces for Movement Planning Import

AIT

CAEMS (Computer Aided Embarkation Management System) Import (Marines)

COMPASS (Computerized Movement Planning and Status System) Import (Army)

NOTE: A COMPASS import should only be done to a plan that was previously exported to COMPASS.

ICODES Import (Army)

JFRG Import (Joint)

LOGMOD (*.CMC)/(*.PLN) Import (Air Force)

MAGTFII Import (Marines)

MANPER DRMD Import (Air Force)

MANPER Per Import (Air Force)

MDSSII Import (MAGTF Deployment Support System II) (Marines)

SIDPERS Import (Army)

TCACCIS Import (Army)

TCAIMS V3 PLAN Import

UD/MIPS Import (Marines)

Exports

1.
Click Wizards.

2.
Select Interface.

3.
Select Import/Export.

4.
Click the Movement Planning Radio Button.

5.
Click Ok.

6.
Click Export and then Next.


NOTE: if exporting COMPASS see COMPASS Interface below.

7.
Select required interface and click Finish.

8.
Select the drive where the file is to be saved, name the file and click Save.

Interfaces for Movement Planning Export

AALPS (Automated Air Load Planning System) Export (Army)

CAEMS (Computer Aided Embarkation Management System) Export (Marines)

COMPASS (Computerized Movement Planning and Status System) Export (Army)

1.
Click Preferences, select the interface COMPASS from the scroll down option.

2.
Select Retrieve.

3.
Enter the Originator FTP or e-mail address and click Update.

NOTE:  Ensure Preference data is entered for both COMPASS and GTN reports.

4.
Select the Message Submission Type, Attachment.

5.
Enter the Recepient’s address.

6.
Click Close.

7.
Select Compass in the Interface window and click Finish.

8.
The Export Compass window opens with the UIC Export List window and select ASCII radio button in the  FTP organization information..

9.
Select the desired UIC and CIC.

10.
Select either the Send, Resend, or Save As button.  When action completes, Close the Compass Export window.

GTN (Global Transportation Network) Export (ARMY)

ICODES (Intergrated Computerized Deployment System) Export (ARMY)

Joint Force Requirements Generator II (JFRG II) Export (Joint)

LOGMOD (*.PLN) Export (Air Force)

MAGTFII Export ( Marines)

MANPER DRMD Export (Air Force)

MDSSII Export   (Marines)

TCACCIS Export (Army)

TCAIMS V3 PLAN Export

Reports Wizard

1.
Click Wizard.

2.
Click Reports. 

3.
Click the radio button for Movement Planning.

4.
Click OK. 

5.
Select the required report then click OK.  

6.
Select any additional requirements necessary.

AD HOC Reports

AdHoc Reports are created using InfoMaker, a commercial off-the-shelf product. 

1.
Select AdHoc report from the reports window.

2.
This will start the InfoMaker.  

3.
In Server Name, enter the name your standalone.

4.
Enter the User ID and password you use for TC-AIMS II.

5.
Leave the Application Name and Host Name fields blank.

17. Click OK.  

18. Click OK to select the TCAIMSII_USER database.

NOTE:  This is the default.

19. Click Report icon.

20. Click New button.  

21. Select the Data Source and Presentation Style then click OK.

22. Select the table(s) that you want to pull information from then select the column(s).
23. Click OK or close the table selection window.  

24. Select Preview from the Design menu.  

Note:  To make changes, select Edit Data Source from the Design menu.  

25. Save the report.

26. To print - preview the report and then select Print from the File menu.
27. Select Exit from the File menu.  InfoMaker closes and returns to TC-AIMS II.
Reports Available for Movement Planning

Convoy Clearance Report

Daily Table of Authorized Material (TAM) Summary Report

Equipment List Summary for Wheeled/Tracked Report

PAX-Assigned Report/Roster by Rank Report

Convoy March Table Summary Report

Association Report

Special Hauling Permit

Force Personnel Over/Short Report

NOTE:  This report can only be generated if a UDL Roster has been created in the selected plan.

Force Equipment Over/Short Report

NOTE:  This report can only be generated if a UDL has been created in the selected plan.

Unit Audit Listing – Cargo Report

Unit Audit Listing – Personnel Report

Unit Audit Listing – Vehicle Report

General Convoy Summary Report

Item ID Summary Report

Convoy Clearance by Date Report

Road Movement Bid Credit Granted Report
NOTE:  This is an USAREUR specific form.  It is only used in Europe.

PAX Assigned Report

PAX Unassigned Report

Convoy March Tables Report

Equipment List by Serial/Bumper Number Report

Equipment List Summary Report

Equipment List Bumper Number Summary Report

UDL Unit Equipment List Report

AUEL –CSRO Report
NOTE:  Currently this report is not functioning.

AUEL – Commercial Requirements Report

NOTE:  Currently this report is not functioning.

Packing List DD Form 1750 Report

Movement Coordination

The Movement Coordination BPA provides DoD units the capability to request transportation assets in support of unit movements.  It allows the coordination of personnel and surface or air freight movement requirements from origin to destination as established during the Movement Planning process, Create Unit Deployment List (UDL) with/without Time Phased Force and Deployment Data (TPFDD) Requirements.  Movement Coordination is a series of processes and tasks that provide the “checks and balances” for TC-AIMS II to transit from the Movement Planning BPA to the Movement Execution BPA.  

Receive Movement Request

Import Request

1. Double-click Movement Coordination.

2. Double-click Receive Movement Request.

3. Double-click Import Request.  

4. Click Yes when prompted with  ‘If the reference data is inconsistent between the Request-originating database and this database, Foreign key constraint errors may occur. Do you wish to continue?’  

5. Select the file that will be imported and then click Open.  
6. Once editing is complete, click OK to save.
CAUTION:  The system does not display a confirmation message stating that the Movement Requests were successfully imported. Each request must be imported singularly.

NOTE:  If an attempt is made to import a request containing unauthorized UICs, the system displays the following message:  ‘Importing Unauthorized UICs!  Please contact the System Administrator to add the following UIC(s) to your profile.’  The user is allowed to print the error message by clicking the print button.  The Input button allows for comment (on the printout) from the user pertaining to the discrepancy.  The user may take this message to the System Administrator (SA) for corrective action.  This message requires an acknowledgement by clicking the OK button.

Open Request

New Requests

1. Double-click Movement Coordination.

2. Double-click Receive Movement Request.

3. Double-click Open Request.

4. Double-click New Requests.  There are three options for viewing the requests:

a. All – all new requests are viewed in the listing.

b. Request NR – type the desired request number in the blank data field at the top of the screen and then click on the Retrieve button – the selected request record displays in the window.

c. UIC – type the desired UIC alpha/numeric characters in the blank data field at the top of the screen and then click on the Retrieve button – requests with the selected UIC will display in the window.

5. Click the request to be viewed in detail and then click OK.  
Active Requests

1. Double-click Movement Coordination.

2. Double-click Receive Movement Request.

3. Double-click Open Request.

4. Double-click Active Requests.  There are three options for viewing the requests in this listing:

a. All – all new requests are viewed in the listing.

b. Request NR – type the desired request number in the blank data field at the top of the screen and then click on the Retrieve button – the selected request record displays in the window.

c. UIC – type the desired UIC alpha/numeric characters in the blank data field at the top of the screen and then click on the Retrieve button – requests with the selected UIC will display in the window.
5. Click the request to be viewed in detail and then click OK.  

Manually Add a Request

1. Double-click Movement Coordination.

2. Double-click Receive Movement Request.
3. Double-click Manually Add a Request.  
4.
Input all necessary information.
NOTE:  Double-clicking in a field requiring date information will display a calendar to select from.

5.
Once all data entries have been made, click OK.  
6. 
Click OK when prompted “Request Saved”.  
7.
Click the box at bottom of window to add equipment requiring support.
8.
Right-Click and select Add.  
NOTE:  Before adding equipment to a request, ensure that a Plan Name has been selected using the look-up table available from that field.    

9.
Double-click in the UIC field.  
10.
Click the record that you want to add to the request and click OK.  
11.
When all data has been entered, click OK to save.

Task a Request

1.
Click Tasks.  
2.
Click New.  

3.
Select the type of task to create, Organic or Commercial, and click OK.  

4.
Make the necessary selections for the Mode, Priority, and Status fields.

5.
Enter the necessary information in the From, To, and the PAX (if required).  

6.
Click OK to save.  

7.
Click Funding.  

8.
Enter the necessary information then click OK to save.

9.
Click Cancel to close.

Schedule Movement

Prioritize Loads

1. Double-click Movement Coordination.

2. Double click Schedule Movement.

3. Double-click Prioritize Loads.  
4. Select the appropriate Mode from the drop down list.
5. Select the appropriate Category (Personnel or Cargo).
NOTE: Selecting neither will display all information.
6. Click a record to view the details.
7. Click the down arrow for Task Priority and select the necessary task priority rating.
8. Click OK to save.  

9. Click Yes when prompted for save.

Calendar of Events

1. Double-click Movement Coordination.
2. Double click Schedule Movement.
3. Double-click Calendar of Events.

4. Click New.

5. Enter the necessary data using look-up tables where applicable.

6. Click Save.

7. Click Cancel to close.  

Special Assignment Airlift Mission (SAAM) Request

NOTE:  Before generating a SAAM Request, you must first create a Plan or open a Plan that has an Air Leg with a Special Airlift indicator (Mode F). Cargo or Passengers from the Air leg must also be loaded on an air conveyance.
Create a new SAAM Request

1. Double-click Movement Coordination.

2. Double-click SAAM Request.
NOTE:  Presently only one SAAM Request may be created per Air Leg, however the SAAM Request may be edited after being created and saved.  
3. Click Create New SAAM/JCS Request, and click OK.
4. Select the aircraft in the current opened plan for the SAAM request and click OK.
a. The top half of the screen will display the following data:

Special Airlift Request ID;  XE "Exercise" Request Date; SAAM Number; JOPES Plan ID; Plan Name; Originating Unit ID; Project/Exercise Name; Airlift Priority; Flagstop Channel Ext:  enter Y/N; Security Classification; Info Addr: enter Yes/No; Plan Origin; Plan Destination; Billing

b. The bottom half of the screen will also display data entered.

1) All grayed out fields are data autopopulated and may not be edited in Movement Coordination, changes must be made to the Plan Leg in Movement Planning.

2) Select the following tabs and review or enter data as needed:

a) Onload/Offload, when selected information will display.  The ALD, Desired pickup, and LAD times must be entered in Local time.  

b)
When Mission Rqmts is selected Aircraft Configuration can be selected from the drop-down list.  Mission Support Requirements is open text.

c)
When Load is selected all fields will display grayed out are data autopopulated.  Any changes must be made to the Plan Leg in Movement Planning.

d)
When Hazcomm is selected, data will populate with the corresponding piece of equipment on the Load tab.  Any changes must be made to the Plan Leg in Movement Planning.

e)
When Contacts is selected, right click in POC Type.  Select Add.  Click the down arrow.  Select a POC, and enter necessary data.  Right click and select Add to add additional records.
f)
When Remarks is selected, right click Remarks Type.  Select.  Click the down arrow.  Select a Remark, and enter all necessary data.  To add another Remark, right click again and repeat procedures.  

3) Once complete, click OK to save.  

4) Click OK when prompted with ‘SAAM Request successfully saved!’ then Cancel to close.

Review a Newly Created SAAM Request

1. Double-click Movement Coordination and select SAAM Request.
2. Select Opening Existing SAAM/JCS Request and click OK.
3. Select the desired Project Name and click OK.

4. Review the desired information by clicking on the appropriate tabs.

5. Click Cancel to close.

NOTE:  Reminder, changes to the ALD, Desired Pickup, or LAD time must be entered in Local time, the system will convert to Zulu time.

Delete a SAAM Request

1. Double-click Movement Coordination and select SAAM Request.
2. Select Open Existing SAAM/JCS Request and click OK.
3. Select Project Name and click Ok.

4. Click Delete Request. 

5. Select Yes when prompted with ‘Do you wish to delete the current SAAM/JCS Request?’

NOTE:  Another Delete Option.  Right click and select Delete in step 4.
SAAM Export Using the Interface Wizard

1. Click Wizards.

2. Highlight Interfaces.

3. Click Import/Export.  

4. Click Movement Coordination and click OK.  

5. Highlight Export and click Next.

6. Highlight SAAM and click Finish.

7. Highlight the selected SAAM request and click Export.

8.
Select the desired drive to export to and click Save.

Track Shipment

NOTE:  This is a view only screen 

1. Double-click Movement Coordination.

2. Double-click Track Shipment.  
3. View information on the conveyance, cargo, and passengers being tracked.
4. Click Close.

Reports Wizard

1. Click Wizards.

2. Click Reports.  

3. Click Movement Coordination 

4. Click OK.

5. Click required report and select any additional critera required.

6. Click OK.   

7. Click File then Print to print.

8. Click File then Close to close.

AD HOC Report

AdHoc Reports are created using InfoMaker, a commercial off-the-shelf product. 

1.
Select AdHoc report from the reports window.

2.
This will start the InfoMaker.  

3.
In Server Name, enter the name your standalone.

4.
Enter the User ID and password you use for TC-AIMS II.

5.
Leave the Application Name and Host Name fields blank.

28. Click OK.  

29. Click OK to select the TCAIMSII_USER database.

30. Click Report icon.

31. Click New button.  

32. Select the Data Source and Presentation Style then click OK.

33. Select the table(s) that you want to pull information from then select the column(s).
34. Click OK or close the table selection window.  

35. Select Preview from the Design menu.  

Note:  To make changes, select Edit Data Source from the Design menu.  

36. Save the report.

37. To print - preview the report and then select Print from the File menu.
38. Select Exit from the File menu.  InfoMaker closes and returns to TC-AIMS II.
Arrival Report

NOTE:  The Arrival Report is populated with data from the Truck, Water, or Air manifest in Movement Execution.

Transportation Request

NOTE:  A Transportation Request must be prepared first to generate this report properly.

Movement Execution

The Movement Execution BPA is the culmination of all the Asset Management, Movement Planning, and Movement Coordination efforts in TC-AIMS II.  This is where the detailed information developed during the planning and coordination phases is now ready for execution.  Execution activities include the actual conduct of movement and begin with the receipt of the execution order.  Movement Execution depends on accurate input from Asset Management, Movement Planning, and Movement Coordination.  These BPAs are integral players within TC-AIMS II and feed the execution phases.  

Execute Plan Leg

1.
Double click Movement Execution.

2.
Double click Execute Plan Leg.

3.
Select the plan, and click OK.


4.
Double click the Plan Name.

6.
Click the Segment.  

7.
Highlight the desired Leg.  

8.
Click Execute.  

9.
Click Yes, when prompted with Execute Confirmation.  

10.
Click OK.

11.
Select Create TCNs for All items in this plan.

12.
Click OK.  

13.
Click OK when prompted with Finished.  

Edit Assets

UDL

Assign/Source Equipment

1.
Double click Movement Execution.

2.
Double click UDL.

3.
Double click Assign/Source Equipment.  

4.
Click Yes when prompted to open an Executed Plan
5.
Open an Execution Plan.

NOTE:  This process is identical to Assign/Source Equipment located in Movement Planning.  

Assign/Source Personnel

1.
Double-click Movement Execution.

2.
Double-click UDL.

3.
Double-click Assign/Source Personnel.  

4.
Click Yes when prompted to open an Executed Plan
5.
Open an Execution Plan.

NOTE:  This process is identical to Assign/Source Personnel located in Movement Planning.

Movement Plan

1.
Double-click Movement Execution.

2.
Double-click UDL.

3.
Double-click Movement Plan.

4.
Click Yes when prompted to open an Executed Plan
5.
Open an Execution Plan.


NOTE:  This process is identical to Movement Plan located in Movement Planning.  

Consolidate/Load Assets

Linker

1.
Double-click Movement Execution.

2.
Double-click Consolidate/Load Assets.

3.
Double-click Linker.  

4.
Click Yes when prompted to open an Executed Plan
5.
Open an Execution Plan.


NOTE:  This process is identical to Assign/Associate located in Asset Management.

ME Loader

1.
Double-click Movement Execution.

2.
Double-click Consolidate/Load Assets.

3.
Double-click ME Loader.  

4.
Click Yes when prompted to open an Executed Plan
5.
Open an Execution Plan.


NOTE:  This process is identical to MP_Loader located in Movement Planning.

Swap Conveyance

1.
Double-click Movement Execution.

2.
Double-click Consolidate/Load Assets.

3.
Double-click ME Loader.  

4.
Click Yes when prompted to open an Executed Plan
5.
Open an Execution Plan.

8.
Click the (+) next to the desired Segment.   

9.
Click the (+) next to the desired Leg.  

10.
Click the (+) next to the desired Conveyance.

11. 
Double-click Conveyance that equipment/personnel needs to be moved from.

11.
Click Swap Conveyance.  


NOTE:  Ensure that you have selected either Equipment or Personnel radio button.

12.
Select the Conveyance that equipment/personnel are to be moved to.

12.
Click the Yes when prompted with “Do you really want to move items/personnel to a different leg.  

13.
Click OK when complete.  

Seal Numbers

1.
Double-click Movement Execution.

2.
Double-click Consolidate/Load Assets.

3.
Double-click Record Seal Numbers.  .

4.
Click Yes when prompted to open an Executed Plan.  

5.
Open an Execution Plan.  

6.
Highlight a record and click Add.  

a. Enter the Seal Number.

b. Enter the Date and Time.  (Double click to get calendar)

c. Click OK.

d. Click Seal Report.  

e. View the contents of the TCAIMS II Seal Report.  Print if necessary.

7.
Click Cancel to close.

Support Requests

Tasks

1.
Double-click Movement Execution.

2.
Double-click Support Requests.

3.
Double-click Tasks.  

a. Highlight a request and click OK.  

b. Click Tasks.  

c. Select New.  

d. Select either Commercial or Organic and click OK. 

e. Enter all necessary information. 

NOTE:   Fields are mandatory unless otherwise indicated.

f. Highlight the Equipment Item(s) at the bottom of the Edit Task screen.

g. Click Assign.  

h. Click Save and then OK.  

i. Click Funding.  

j. Enter all necessary information.

k. Click OK to save and close the screen.

l. Click Export.  

m. Specify location to save file in Save In and enter a File Name.

n. Click Save.  

o. Click OK when prompted with “Export Complete.  Make sure to export JDL USER data also along with the request export”

p. Click Delete to delete a task. 

q. Click the appropriate response when prompted with confirmation.

Domestic Routing Request (DD-1085)

1.
Double-click Movement Execution.

2.
Double-click Support Requests.

3.
Double-click Domestic Routing Request (DD-1085).  

a. Click Retrieve.

b. Highlight the Request Number/Task NR and click OK.  

c. Click the down arrow button beside Task ID and select the Task IDNR.

d. Click OK.

e. Enter all necessary information.

Prioritize Loads

1.
Double-click Movement Execution.

2.
Double-click Support Requests.

3.
Double-click Prioritize Loads.  

a. Set the Mode and Category parameters.

b. Click Tasks.

c. Select the Priority.

d. Click OK to save.

Calendar of Events

1.
Double-click Movement Execution.

2.
Double-click Support Requests.

3.
Double-click Calendar of Events.  

a. Select a record.  

b. Click New. 

c. Enter all necessary information.

NOTE:  All field entries are optional except for the Flight Number.

Process Shipping Documents

Create/Edit

Create/Edit TCMD

1.
Double-click Movement Execution.

2.
Double-click Process Shipping Documents.

3.
Double-click Create/Edit.

4.
Double-click Create/Edit TCMD.  

5.
Click Yes when prompted to open Executed Plan. 

6.
Open an Execution Plan.

7.
Click Select All.  

8.
Select a TCMD Type.

NOTE:  All field entries are optional unless otherwise indicated.

11.
Enter all necessary information.

121.
Click Generate.

13.
Click Re-generate to generate a TCMD in which something has changed or if the generation was not successful.  

14.
Click Cancel to close.

15.
Close any plans that are open.

Create/Edit GBL

1.
Double-click Movement Execution.

2.
Double-click Process Shipping Documents.

3.
Double-click Create/Edit.

4.
Double-click Create/Edit GBL.  

5.
Click Yes when prompted to open Executed Plan. 

6.
Open an Execution Plan.

NOTE:  If a plan is selected that is not Rail, a TCAIMSII message window displays the message, “GBLS can be created for RAIL mode only.”
NOTE:  All field entries are mandatory unless otherwise indicated.

7.
Enter the Rail Car No.

8.
Enter the Rail Car Owner.

9.
Enter the Ordered Rail Car Variant.

10.
Select the Ordered Rail Car Type.

11.
Enter the Fur Rail Car Variant.

12.
Enter the Fur Rail Car Type.

13.
Click OK.  

14.
Enter the GBL Control Number.

NOTE:  All fields are mandatory unless otherwise indicated.

15.
Enter all necessary information.

16.
Click Save.
17.
Click Addresses. 

18.
Add appropriate addresses. 

19.
Click OK and then Cancel.

View/Edit
Edit TCMD

1. Double-click Movement Execution.

2. Double-click Process Shipping Documents.

3. Double-click View/Edit.

4. Double-click Edit TCMD.  

5.
Click Yes when prompted to open Executed Plan. 

6.
Open an Execution Plan.

NOTE:  If a plan is selected that is not Rail, a TCAIMSII message window displays the message, “GBLS can be created for RAIL mode only.”

7.
Double-click a record to view the TCMD.

8.
Enter the Date Shipped and edit any necessary information.

9.
Click Ok to save and Cancel to close.

Edit GBL

1.
Double-click Movement Execution.

2.
Double-click Process Shipping Documents.

3.
Double-click View/Edit.

4.
Double-click Edit GBL.  

5.
Click Yes when prompted to open Executed Plan. 

6.
Open an Execution Plan.

NOTE:  If a plan is selected that is not Rail, a TCAIMSII message window displays the message, “GBLS can be created for RAIL mode only.”

7.
Edit all necessary information.

8.
Click Close to close the View/Edit GBL screen.

Cargo Manifest

1. Double-click Movement Execution.

2. Double-click Process Shipping Documents.

3. Double-click Cargo Manifest.  

4. Click Yes when prompted to open Executed Plan. 

5. Open an Execution Plan.

NOTE:  If a plan is selected that is not Rail, a TCAIMSII message window displays the message, “GBLS can be created for RAIL mode only.”

6. Input or edit all necessary information.

7.
Click Ok to save or Cancel to close.

Passenger Manifest

1. Double-click Movement Execution.

2. Double-click Process Shipping Documents.

3. Double-click Passenger Manifest.

4.
Click Yes when prompted to open Executed Plan. 

5.
Open an Execution Plan.


NOTE:  The system automatically assigns the personnel to the Passenger Manifest.

6.
Highlight the Passenger Name and click the Assign. 

7.
Highlight the Passenger Name, and click Un-Assign.  

8.
Click Save to save.

9.
Add Check Bag(s), and Remarks to a passenger, if required

Air Movement

Aircraft Mission Status

1.
Double-click Movement Execution.

2.
Double-click Process Shipping Documents.

3.
Double-click Air Movement.

4.
Double-click Aircraft Mission Status.  

5.
Highlight ACFT Type
6.
Update the ACFT Tail No
7.
Click OK to save.

Chalk Summary

1.
Double-click Movement Execution.

2.
Double-click Process Shipping Documents.

3.
Double-click Air Movement.

4.
Double-click Chalk Summary.  

NOTE:  This is a View only Screen.

Passenger Listing

1.
Double-click Movement Execution.

2.
Double-click Process Shipping Documents.

3.
Double-click Air Movement.

4.
Double-click Passenger Listing.  If there is no green check mark check (()the individual has not been assigned in Passanger Manfest. 

5.
Click the Close button on the Passenger Listing.

Troop Commander’s Briefing

1.
Double-click Movement Execution.

2.
Double-click Process Shipping Documents. 

3.
Double-click Air Movement.

4.
Double-click Troop Commander’s Briefing.  

5.
Click Print to print the list, if required.

6.
Click Cancel to close.

Passenger Briefing Checklist

1.
Double-click Movement Execution.

2.
Double-click Process Shipping Documents.

3.
Double-click Air Movement.

4.
Double-click Passenger Briefing Checklist.  

5.
Enter any necessary information and print if required.

Shippers Declaration

1.
Double-click Movement Execution.

2.
Double-click Process Shipping Documents.

3.
Double-click Air Movement.

4.
Double-click Shippers Declaration.  

a.
Make necessary changes to the Modify Detail Shippers Declaration .  

b.
Click Ok.  

c.
Click Yes when prompted to save changes.  

d.
Click Cancel to close.

Track Movement

Due-In Log

1.
Double-click Movement Execution.

2.
Double-click Track Movement.

3.
Double-click Due-In Log.  

4.
Make any necessary changes.

5.
Click OK to save.

Status

1.
Double-click Movement Execution.

2.
Double-click Track Movement.

3.
Double-click Status.  

NOTE:  The Status column is automatically populated with three possible statuses:

•
Pending - means the Scheduled Departure and Arrival Dates are entered.
•
Executing – means the Scheduled Departure and Arrival Dates Actual Departure Date are entered.
•
Complete - means that all Scheduled and Actual dates are entered.
NOTE:  These date/times are entered in the Status Conveyance tab and/or the Cargo Manifest screen option.  Air Plan also has to come from the ACFT Mission Status.

4.
CONVEYANCE TAB ENTRIES:

a.
Select the Plan Name with the correct Conveyance.

b.
Enter any necessary information.

c.
Click OK.

d.
Click the Refresh button on the toolbar.  The Status column now contains Pending, Executing, and Complete status information for the conveyance that was updated.
5.
CARGO TAB ENTRIES:

a.
Click the Cargo tab 

b.
Select the Plan Name with the correct Conveyance.
d.
Highlight the desired TCN.  A check mark indicates that an action may be required.

e.
Left-click a check mark.  The icon is changed to a pencil eraser and the current date and time are automatically entered in the corresponding data field.

f.
Enter any additional information.

g.
Click OK.
6.
PAX TAB ENTRIES:

a.
Click the PAX tab.

b.
Highlight the Plan Name with the correct Conveyance.

c.
Select the desired Passenger Name.

h.
Enter any necessary information.

Departure Report

1.
Double-click Movement Execution.

2.
Double-click Track Movement.

3.
Double-click Departure Report. 

4.
Click Yes, when prompted to open an Execution Plan.  

5.
Open an Executed Plan.

6.
To print PAX Departure Report or Departure Report CARGO by clicking on the tab and then printing

7.
Click Cancel.

8.
Close the open plan.

Interface Wizard Task

Imports

CAUTION:  If the import process experiences problems when attempting to import from another service system, verify that the directory or the file name does not contain a space.  Several of the Interfaces will not allow spaces in the path or file name. 

Workaround:  During some imports, the Windows NT operating system fails to accept when a disk has been removed from the computer and will display the following error, “tcaims.exe – No Disk”.   The workaround resolution for this error message is as follows:  Re-insert the diskette into the drive.  The error window will go away.  Then use Windows NT Explorer to copy the file from the diskette to a location on the hard drive.  The error window message should not reappear.
3. Click Wizards.  

4. Select Interfaces.

3.
Select Import/Export.  

4.
Click Asset Management radio button.

5.
Click OK.  

6.
Select Import then click Next.  

7.
Click the required interface.

e. To view records that were previously imported for a specific interface, click on the box beside Previously imported data only then click Finish.

f. To perform a new Import, click Finish.  

g. Select the location of the saved file and click Open.  

h. Click Ok.

NOTE:  If an import was previously performed and records remain in the Interfaces Newcargo AIT window – a message will display asking if you wish to delete these records.  Click on OK to delete the records and continue with the import.  Click on Cancel to stop the import process.

7.
Click Finish.

8.
When finished verifying information in the New Interface window Click Apply. 

9.
Click Ok the number of records applied, updated or rejected. 

10.
At this point the user has three options:

d. Close the window and correct the rejected records at a later time.  The Interface Newcargo AIT window can be reopened by following steps 1-4a above.

e. Delete the rejected records by right mouse clicking on each record in the top listing and selecting delete from the drop down listing.

f. Correct the rejected records and apply them to the database.

Interfaces for Movement Execution Import

AIT (Automated Information Technology)

NOTE:
  When “Import AIT – Railroad?”  Click No.

CMOS (U.S. Air Force Cargo Movement Operations System)

IBS (Integrated Booking System)

ICODES (Integrated Computerized Deployment System) 

TCAIMS V3 PLAN 

Export

Workaround:  During some exports, the Windows NT operating system fails to accept when a disk has been removed from the computer and will display the following error, “tcaims.exe – No Disk”.   The workaround resolution for this error message is as follows:  Re-insert the diskette into the drive.  Re-export the file to a hard drive location.  Close the export window and the Error window message should not reappear.  If desired, delete the exported file from the hard drive.

NOTE:  Many of the export interfaces are designed to work with the e-mail system.  It is imperative that e-mail is connected and operational prior to initiating a TC-AIMS II e-mail export.  If the e-mail system is not connected and operational the TC-AIMS II system will hang until the user performs a Ctrl-Alt-Delete and closes the TC-AIMS II program.

1.
Click Wizards.

2.
Select Interface.

3.
Select Import/Export.

4.
Click the Movement Planning Radio Button.

5.
Click Ok.

6.
Click Export and then Next.

7.
Select required interface and click Finish.

8.
Select the drive where the file is to be saved, name the file and click Save.

CAEMS (Computer Aided Embarkation Management System) (Marines)

CFM (CONUS Freight Management System – Electronic Transportation Acquisition (CFM-ETA)

CMOS (Catgo Movement Operations System)

COMPASS ISR (Computerized Movement Planning and Status System)

GATES (Global Air Transportation System) Air 

GATES (Global Air Transportation Execution System) PAX

GATES (Global Air Transportation Execution System) TRUCK 

GTN (Global Transportation Network) AIR 

GTN (Global Transportation Netwrok) ISR 

GTN (Global Transportation Network) PAX 

GTN (Global Transportation Network) Truck Export

IBS (Military Traffic Management Control (MTMC) Integrated Booking System) 

ICODES (Integrated Computerized Deployment System) 

LOGMOD (Logistics Module) (*.DCM) 

TCAIMS V3 PLAN 

WPS (Military Traffic Management Command (MTMC) Worldwide Port System) 

Reports Wizard

1.
Click Wizard.

2.
Click Reports. 

3.
Click the radio button for Movement Planning.

4.
Click OK. 

5.
Select the required report then click OK.  

6.
Select any additional requirements necessary.

AD HOC Reports

NOTE:  This report is identical to ADHOC Reports in Asset Management except select the Movement Execution Business Practice.

Passenger Manifest

ATCMD

TCMD

Inspection Check List DD Form 2133

Domestic Freight Routing Request and Order

Shipper's Declaration for Dangerous Goods

Cargo Manifest DD Form 1385

Packing List DD Form 1750

Special Handling DD Form 1387-2

Emergency Inst for Motor Veh. Drivers DD Form 836

Check Sheet and Delivery Record MCBCL 4460/1

Ocean Cargo Manifest Recapitulation

Ocean Cargo Manifest Summary

U.S. Government Bill of Lading

Truck Manifest

Print/Create Labels

1.
Double-click Movement Execution.

2.
Double-click Track Movement.

3.
Double-click Print/Create Labels.  

4.
Click Yes when prompted to open an Execution Plan.  

5.
Click Select All.

6.
Select the type of label to be printed.

7.
Select Yes if using a Zebra Printer.

8.
Download Printer format if necessary.

9.
Enter Ship to and Ship from if required.

10.
Click Print.  

11.
Click Ok when prompted with completion.

12.
Click Close.

13.
Click Cancel to close.

Services and AIT

Import Reference Data

1. Click Services.

2. Click Import Reference Data.  

NOTE:  The Overwrite Existing Records button default is Yes.  When a Joint Data Library (JDL) change is put into the system, it will not overwrite any manually input data, unless that data is actually being changed/updated.

3. Click Import.  

4. Click the down arrow next to the Look in to locate the file to import.

5. Click Open.  

6. Click OK.

NOTE:  Imported data may over-write, add, or delete existing data.  Imported data does not delete or otherwise modify data input through manual keyboard input, unless an imported file is updating it.

7. Click the “X” to close.

Maintain Reference Data

1. Click Services.

2. Click Maintain Reference Data.  

3. Click OK.

4. Make the necessary changes.

5. Click Save to save.

6. Click the “X” to close.

Export Reference Data

1. Click Services.

2. Click Export Reference Data.  

3. Highlight the tables to export.

4. Click Export.  

5.
Click the down arrow next to the Look in to locate the file to export.

6.
Name the file and click Save.

5. Click the “X” to close.

Maintain NSN Data

Search for NSN Data

1. Click Services.

2. Click Maintain NSN Data.  

3. Click Search by down arrow and select search criteria

4. Click Search.  

5. Click Cancel to close.

View and Edit NSN Data of Selected NSN Record.

1. Click Services.

2. Click Maintain NSN Data.  

3. Click on a search category.

4. Click Search.

5. Click Edit make any necessary changes.
6. Click Ammunition Component tab.  

NOTE:  Do not click the Add button when on the Ammunition Component tab.  One NSN will not normally have multiple DODICs (Ammunition Component Codes).  For non-ammunition items, this tab is blank.

7. Click Hazard Indicator box to activate this field.  Do not make any other Hazard edits.

8. Edit the Weight fields.  

9. Click OK to save edits.

10. Click Transportable Item/LIN Index tab.  This tab is blank.

NOTE:  Do not click the Add button to edit an NSN record with Transportable Item Data; this is accomplished in Maintain Transportable Item Data.

Add an NSN record (local reference data record)

1. Click Services.

2. Click Maintain NSN Data.  

3. Click Add.  

4. Click Add to MIS Hazard.  Enter data using a lookup table or manually, as appropriate.

5. Click OK to save.

6. Click Cancel to close.

Reference Wizard in Maintain NSN Data

1. Click Services.

2. Click Maintain NSN Data.  

3. Click on a search category.

4. Click Search.

5. Click Start Wizard.  

6. In Maintain NSN Data, select required records.

7. Click Wizard.  

8. Click Finish.  

9. Click Stop Wizard.  

10. Click Cancel to close.

Autopopulate in Maintain NSN Data

1. Click Services.

2. Click Maintain NSN Data.  

3. Click on a search category.

4. Click Search.

5. In Maintain NSN Data click Autopop.

6. Click the Yes when prompted for confirmation.  

7. Click OK.  

8. Click Cancel to close the.

Maintain Transportable Item(s)

Search for Transportable Item Data

1. Click Services.

2. Click Maintain Transportable Item(s).  

3. Click Search by
4. Click on a search category.  

5. Enter search criteria.

6. Click Search.  

7. Click Cancel to close.

View and Edit Transportable Item Data

1. Click Services.

2. Click Maintain Transportable Item(s).  

3. Click on a search category.

4. Enter search criteria.

5. Click Search.  

6. Click Display Detail(s).  

7. Click a record and click Edit and make necessary changes.

a. Right clicking in Axle and select Add to add new data.

b. Clicking OK to save.

8. Select NSN (Material Item Supply) tab.  

a. Click Add to MIS Hazard to add additional hazard for the NSN record

b. Clicking OK to save.

9. Select Transportable Item/LIN Index tab, edit/populate the Ammunition Component.

10. Double-click DODIC.

11. Select a value from the table and click OK.

12. Click OK to save.

13. Select Ammunition Component tab.  

14. Manually edit Weight fields.

15. Populate the Hazard fields by first using the lookup table supporting PSN ID.

NOTE:  Do not click the Add button when on the Ammunition Component (ACP) tab.  One NSN will not normally have multiple DODICs (Ammunition Component Codes).

16. Click OK to save.

17. Click Cancel close.

Add a Transportable Item Record (Local reference data)

1. Click Services.

2. Click Maintain Transportable Item(s).  

3. Click Add.

4. Enter Item ID and Description and click OK.

5. Right-click in the table area under the Main section and click Add.

6. Double-click NSN.  

7. Select the NSN for the transportable item being added and click OK.  

8. Enter additional information and click OK to save.

9. Click Cancel to close.

Reference Wizard in Maintain Transportable Item Data

1. Click Services.

2. Click Maintain Transportable Item(s).  

3. Click on a search category.

4. Enter Search Criteria.

5. Click Search.  

6. In Maintain Transportable Item Data, click on the selected Item ID.

7. Right-click and select Display Detail(s).

8. Click Start Wizard.  

9. Select the desired LIN Index/Item Configuration record(s).  

10. Click Wizard.  

11. Click Finish.  

12. Click Stop Wizard.  

13. Click Cancel to close.

Autopopulate in Maintain Transportable Item Data

1. Click Services.

2. Click Maintain Transportable Item(s).  

3. Click on a search category.

4. Enter Search Criteria.

5. Click Search.  

6. In Maintain Transportable Item Data, click on the selected Item ID.

7. Right-click and select Display Detail(s).

8. In Maintain Transportable Item Data click the Autopop button.

9. Click the Yes when prompted with confirmation.

10. Click OK.  

11. Click Cancel to close.

Data Collection Device (DCD) Instructions

Install the Rechargeable NiCad Battery Pack

1. Hold the DCD with the handle pointing down.

2. Position the battery pack underneath the empty DCD handle with the molded rubber end of the pack on the bottom.

3. Slide the battery pack up into the DCD handle.

4. Push firmly on the bottom of the pack until it locks into the handle.  Two clicks will be heard as the battery pack latches into the DCD handle.

Remove the Rechargeable NiCad Battery Pack

NOTE:  Removing the battery pack while the DCD is on may cause loss of data.

1. If on, turn off the DCD by pressing the I/O button.

2. Hold the DCD with the handle pointing down.

3. Press firmly on the top part of the raised circular button and, at the same time, push the battery pack up until a click is heard.

4. Pull down gently.  The pack will release from the handle and slide down approximately ½ inch before stopping.

5. With thumb and forefinger, firmly squeeze the two yellow buttons and push the pack up a little to release the latches inside the handle.

6. Pull down gently and the battery pack will slide out of the handle.

Recharge the NiCad Battery

There are four ways to recharge the NiCad battery.  The processes will depend on which equipment was issued.

1. Place the battery pack in the battery slot of the docking station and connect an external power supply to the docking station.  This method takes about 2.5 hours.

2. Place the battery pack in the battery charger and connect an external power supply to the battery charger.  This method takes about 2.5 hours.

3. Install the battery pack in the DCD, place the DCD in the docking station DCD slot, and connect an external power supply to the docking station.  This method takes about 15 hours.

4. Install the battery pack in the DCD, attach the optical link adapter to the DCD, and connect an external power supply to the optical link adapter.  This method takes about 15 hours.

Storing the DCD

Suspend Mode

1.
Press the I/O button.

NOTE:  This will place the DCD in Suspend Mode.  The DCD saves all memory contents and turns off the power.  The DCD display is blank when the unit is in Suspend mode.

Resume from Suspend Mode

1.
Press the I/O button.  The DCD resumes exactly where it left off.

Storage Mode

1.
Place the DCD in Suspend Mode.

2.
Press the following keys simultaneously:  F3, 2, ←  (the left arrow on the DCD key pad) and release.

3.
Press 2 again.

4.
Press I/O to turn the DCD on.  The Boot Loader menu appears with the Reboot command highlighted.

5.
Press the ↓ (the down arrow key on the DCD key pad) until Storage is highlighted.

6.
Press Enter to execute the Storage command.

7.
Remove the Nicad battery.

Resume from Storage Mode

1.
Press the I/O button.  The Boot Load menu displays with Reboot highlighted.

2.
Press Enter to reboot the DCD.

3.
A message will display that Storage Mode is on.  Press Enter to continue with the reboot.

NOTE:  The DCD will display at the four options for the TC-AIMS II program (Run, Download Program, Download Trains, Configure).  It is necessary to reload the LOGMARS program, and download the trains. 

DCD Configuration

Cold Boot the DCD

A cold boot is done to clear conventional memory, break out of an application locked in an infinite loop, or recover from an error condition.

NOTE:  When the DCD performs a cold boot, it is necessary to reload the LOGMARS program, and download the trains.
1. Press I/O to turn the DCD off.

2. Press the following keys simultaneously:  F3; 2; ← (the left arrow key on the DCD key pad) and release.

3. Press 2 again.

4. Press I/O to turn the DCD on.  The Boot Loader menu appears with the Reboot command highlighted.

5. Press Enter to execute the Reboot command.

Download LOGMARS

1. Connect the Optical link adapter to the DCD.  

2. Connect the provided Serial cable to the Optical link adapter and then to the COM Port of the computer.

NOTE:  For older DCDs this connection will be done via a SAVI docking station.  

3. On the computer, click Wizards and click Interfaces.

4. Click AIT.  

5. Click Tools then Setup.

6. Click LOGMARS.  

7. Press 2 on the DCD.

8. Click OK on the computer.  

NOTE:  The defaults are correct for this process.  The download begins

9. When the download process has finished, press any key on the DCD to return to the options menu.

NOTE:  If the docking station was connected after the PC was started, it may be necessary to reboot the PC.

Download Trains

1. Connect the Optical link adapter to the DCD.  

2. Connect the provided Serial cable to the Optical link adapter and then to the COM Port of the computer.

NOTE:  For older DCDs this connection will be done via a SAVI docking station.  

3. On the computer, click Wizards and click Interfaces.

4. Click AIT.
5. Click Tools then Setup.

6. Click Download Trains. 

7. Select the Theater of trains to download. 

8. Press 3 on the DCD.

9. Click OK on the computer.  

NOTE:  The defaults for COM port and device are correct for this process.  The download begins.

10. When the download process has finished, press any key on the DCD to return to the options menu.

NOTE:  If the docking station was connected after the PC was started, it may be necessary to reboot the PC.

Operating the DCD

Display Equipment Program Main Menu

1. Press 1 on the DCD.

2. Press Enter when prompted “TC-AIMS II Data Collection System Version 3.0.”

3. The date will display on the DCD change if necessary.

4. The time will display on the DCD change if necessary:

5. The DCD will beep and display a message that the Date and Time have been updated.

6. Press 4 on the DCD.

7. Press the → to highlight Sym.
8. Press the ↓ to highlight *Code 39.
9. Press Enter on the DCD.
10. Press the ↓ to highlight Full.
11. Press the → to change to Mixed.
12. Press the ↓ to highlight OK.
13. Press Enter on the DCD.
14. Press the ← to highlight File.
15. Press the ↓ to highlight Exit.
16. Press Enter on the DCD. 
17. Press Enter on the DCD when prompted to save.
NOTE:  Yes should be the default on the save.  Ensure Yes is highlighted.
Set DCD to Scan TCN

1. Complete 1-5 of the Display Equipment Program Main Menu process.

2. Press 1 on the DCD.

3. Press 4 on the DCD.

4. Select the appropriate mode of transportation.

5. Press 5 on the DCD.

6. Enter AIT Location and press Enter.

NOTE:  The AIT Location must also be created in the AIT Reference Table.  The two entries must be identical.  AIT Location is case sensitive.  

7. Press Enter to bypass MSE.

8. Enter the last two digits of the DCD Serial number for Device number and press Enter.

9. Press Enter to bypass Owner ID.

10. Enter the RailCar Number and press Enter. 

NOTE:  The railcar number is located on the side of the railcar.

11. Enter the Sequence Number and press Enter.

NOTE:  The sequence number is the location of the car (e.g. 1=First 2=Second)

12. Enter the type of Rail Car and press Enter.  

13. Enter the CarAxles and press Enter.

14. Press Enter to bypass the TareWeight.

15. Scan the TCN.

a. Hold the DCD a few inches from the barcode label.

b. Squeeze and hold the yellow trigger on the DCD.

c. Direct the horizontal beam so that it covers all vertical bars in the barcode.  The reader will beep and the laser turns off when complete.

CAUTION:  DO NOT press enter after scanning TCN.  The scanned record will be saved twice causing a duplication error on import.

NOTE:  If the TCN will not scan the TCN can be manually entered and press enter to save the information.

Delete Records on the DCD

1. The DCD must be in the scan TCN mode.

2. Press F3 on the DCD.

3. Press Y to delete the record.

4. Four beeps will be heard and the DCD will display the message, “Record Deleted.”

5. Press F4 when finished.

6. Press F4 to exit.

Reset the DCD

1. Press 6 on the DCD.

2. The system will prompt, “ALL DATA STILL IN DCD WILL BE LOST!  Reset Program?”

3. Press Y on the DCD. 

NOTE:  The LOGMARs and Trains will not be erased.  Only previously scanned information.

Upload Scanned Data

Upload Scanned Data by Cable Upload

1. Connect the Optical link adapter to the DCD.  

2. Connect the provided Serial cable to the Optical link adapter and then to the COM Port of the computer.

NOTE:  For older DCDs this connection will be done via a SAVI docking station.  

3. Press 2 on the DCD.

4. Press 3 on the DCD.

5. Press 1 on the DCD.  DO NOT press Enter.

6. On the computer click Wizards.

7. Click AIT.  

8. Click Tools and select Receive Data.  

9. The File Name field auto-generates a Date/Time group file name.  This can be changed if required maintaining the .ait extention.

NOTE:  The defaults directory will vary and can be changed.

10. Click OK.  

11. Click OK.  The default settings are correct.

12. Press Enter on the DCD.  

NOTE:  The AIT Receive window, on the computer, will display the various locations that have been entered into the DCD and how many records were received for each location.

13. Press Enter on the DCD to purge the records that were uploaded.

14. Click OK on the computer.

15. Click OK when prompted, “Finished Receiving.”

Import AIT Data

1. Click Wizards.

2. Click Import/Export.  

3. Click the Radio button for Movement Execution.

4. Highlight Import and then click Next.  

5. Highlight AIT and click Finish.

6. Select the AIT (.ait) file from it’s saved location.

7. Select the Rail Conveyance that is associated with the import.

8. The Interface Newcargo AIT screen will display when complete.

9. Click Apply.

NOTE:  Records that pass the validations will be posted to the database.  The user will be informed by prompts displaying how many records were inserted, how many records were updated, and how many records were rejected.  Records rejected must either be corrected or deleted.  As will all Asset Management imports the user can suspend work on rejected records by clicking Apply to save all changes made thus far and return at another time to complete the corrections.  The user can get back to the rejected data by completing 1-4 and selecting “Previously imported data” prior to clicking Finish.

Using the TAV in Transit Processing Station (TIPS)

Create an Export Folder

It is recommended that a separate folder be created for storing the .TAV files.

1. Click Start.

2. Click Programs.

3. Click Windows NT Explorer.

4. In the left navigator window, click the drive and/or directory to create the new folder (i.e., C:).
5. Click File and select New, then click Folder.  

6. Rename the new folder TAV Exports.

Export RF Tag Data

NOTE:  .TAV files can only be created for records containing TCNs and TCMD data.

1. Log onto TC-AIMS II.

2. Click Wizards and select Interfaces.

3. Click AIT.  

NOTE:  If a Movement Execution plan is not open, a table displays with a listing the available plans.  Click on the appropriate plan to highlight it and click OK.

4. Ensure that Movement Execution Plans is selected and click OK.  

NOTE:  If no records are displayed in the window, it will be necessary to execute the movement plan again.

5. Click Tools and Select RF Tag Export.  

NOTE:  If no records are displayed in the RF Tag Export table, the records do not contain TCMD data.  

6. Highlight the records to export in one of the following ways:

a. To select one record, click on the record.

b. To select multiple records, click on the first record, then press and hold the Ctrl key and click on each additional record.

c. To select all of the records, click on Select All.  All the records will be highlighted.

7. Click OK.  

NOTE:  The export will create an individual file for each record that was highlighted and the file name is automatically created with the serial number of each record.  

8. Select the drive where the TAV folder was created and double-click it to open.

9. Click Save.  

NOTE:  After each record is exported, the file name and drive/directory of where the file is being saved to can be changed.

10. Click Yes when prompted, “The tag file has been stored in directory TAV Exports Do you want to launch TIPS software to write tags?”

Register the TIPS Station with the Regional Server

1. Connect the Interrogator/Savi Docking Station to the COM Port of the computer and ensure that it is on.

2. Start the TIPS software if not already done. 

3. Ensure the computer is connected to the network.

4. Click Setup and then select Station Information/Register.  

5. Select the UpLoad/Device Tab.

6. Select the server from the dropdown box for Server.

7. Select the mode of communication from the dropdown box for Communication.

8. Select the Device radio button.

NOTE:  The device is not used in the upload, but must be connected to the system.

9. Select the Station Information Tab.

10. Input all required information adhering to the ITV Server Standards.

11. Click Register.  

12. Click Yes when prompted with Saving Changes.

13. Click Close to close.

Import .TAV Files to TIPS

1. Log into TC-AIMS II, if not already logged in.

2. Click Wizards and select Interfaces.

3. Click AIT.  

4. Click Tools and select TIPS.  

NOTE:  When invoking TIPS, the computer will try to access the docking station or the interrogator.  Ensure one or the other is connected.

5. Click File and select Import Shipments.  

6. Click the down arrow for Import File format and select JTAV.

7. Under Import File Pathnames, click Browse.

8. Select the directory the TAV files have been saved

9. Highlight the files and click Use Files.

10. Click Import.  

11. Click Ok when prompted with the number of records imported.

12. Click Close to close.

Read, Write, and Erase RF Tags Using a Docking Station

Setup Savi Docking Station for use with TIPS

1. Connect docking station to the computer.

2. Place an active tag in the docking station.  

3. Log into TC-AIMS II, if not already logged in.

4. Click Wizards select Interfaces.

5. Click AIT.  

6. Click Tools and select TIPS. 

7. Click Setup then select Tag Docking Station and Setup. 

8. Select the Location Tab.

9. Input all required information.

10. Select the DODAAC List Tab.

11. Select all required DODAACS by typing in and clicking Add to List.

12. Click Save Settings.

13. Click OK when prompted with confirmation.

14. Click Close to close.

NOTE:  If changes were made after Registration of the system.  Registration must be completed again.

Read an RF Tag Using a Docking Station
1.
Connect docking station to the computer.

2.
Place an active tag in the docking station.  

3.
Log into TC-AIMS II, if not already logged in.

4.
Click Wizards select Interfaces.

5.
Click AIT.  

6.
Click Tools and select TIPS. 

7.
Click Tags and select Read Tag.  

8.
Enter the Tag ID or click Collect
9.
Click Read Tag.  

10.
Click OK for any prompted message.

11.
To read another tag, remove tag and replace with a new tag, then repeat.

12.
Click Close.

Write an RF Tag Using a Docking Station

1. Connect the docking station to the computer.

2. Place an active tag in the docking station.  

3. Log into TC-AIMS II if not already logged in.

4. Click Wizards and select Interfaces.

5. Click AIT.  

6. Click Tools and select TIPS.  
7. Highlight the file to write to the tag.

8. Click Write to tag.  
9. To write another tag, remove tag and replace with a new tag, then repeat.

Erase an RF Tag With The Docking Station

1. Connect the docking station to the computer.

2. Place an active tag in the docking station.  

3. Log into TC-AIMS II if not already logged in.

4. Click Wizards and select Interfaces.

5. Click AIT.  

6. Click Tools and select TIPS.  

7. Click Tags and select Erase tag.  

8. Enter the Tag ID or click Collect.

9. Click Tag ID and click Erase.  

9. Click Yes when prompted with confirmation.  

10. Click OK.

11. To erase another tag, remove tag and replace with a new tag, then repeat.

12. Click Close to close.

13. Write Tags if required.

Collect, Read, Write, and Erase RF Tags Using an Interrogator

Configure TIPS for Using an Interrogator

1. Connect the interrogator to the computer.

2. Log into TC-AIMS II, if not already logged in.

3. Click Wizards and select Interfaces.

4. Click AIT.  

5. Click Tools and select TIPS.  

6. Click Setup then Interrogator, and click Setup.  

7. Enter all required information on the Location and DODAAC tabs.

8. Click Save Settings.

9. Click Close to close.

Collect, Read, Write, and Erase an RF Tag Using an Interrogator

NOTE:  This process is no different than the process used when using the Savi Docking Station.  The only exception is the active tag is not placed in the Interrogator.  It can be placed somewhere within 300 meters of the Interrogator.

Upload Data to the Regional Server

1. Click File and then click Upload Written Shipments.

2. Click Yes when prompted, “Are you sure you want to upload TIPS data to the Regional Server?”

Import Tag Data to TC-AIMS II

NOTE:  Ensure that the appropriate Movement Execution plan is open before updating the records; otherwise the system cannot update the records.

1. Log onto TC-AIMS II if not already logged in.

2. Click Wizards and select Interfaces.

3. Click AIT.  

4. Select Movement Execution Plans, highlight the Plan and click OK.

5. Click Tools and select Import Tag Data.  

6. Highlight the records to update and then click Import Tags.

7. Click Close.

8. If the Movement Execution plan is open, click OK.  If the plan is not open, highlight plan and then click OK.  

9. Scroll to the right in the AIT window and locate the TAG ID field.  

Erase a Tag ID from a TC-AIMS II Record

1. Log onto TC-AIMS II if not already logged in.

2. Click Wizards and select Interfaces.

3. Click AIT.  

4. Select Movement Execution Plans, highlight the Plan and click OK.

5. Scroll to the right in the AIT screen and locate the Tag ID field.

6. Click the Tag ID field to highlight it.

7. Press the Delete key on the keyboard.

8. Click the Save icon (the floppy disk picture).

9. Repeat steps 6-8 as necessary.
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